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ABSTRAKT

Tématem diplomové prace je vytvoreni modelu transportu sedimentii v programu
HEC — RAS ve spolupraci s GIS. ReSerSni Cast se vénuje popisu sediment
(charakteristiky, pocatek pohybu, funkce pro vypocet) nachazejici se v korytech
tokli. V praktické casti je sestaven model transportu sedimentli na fece Opavé
s vyuzitim programu ArcGIS s extenzi HEC—geoRAS.

Préace se zabyva obecnym pohledem na danou problematiku a tak vytvaii obecny

navod.

Kli¢ova slova:

transport sedimentti, modelovani, HEC-RAS, GIS

SUMMARY

The objective of this diploma thesis is the construction of a model of sediment
transport in the HEC-RAS program using GIS tool. Description of riverbed
sediments (characteristics, motion initiation, models for calculation) is presented
in the introduction. Model of sediment transport (HEC-RAS), constructed using
the Arc-GIS program with HEC-reoRAS extension, in the river Opava is presented
in the practical part of this dissertation. This dissertation focuses on achieving

a general approach to the problem and thus aims to provide a general solution.
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1. Uvod

Stékani vody po terénu, proudéni v bystfinném ¢i fi¢nim koryté ptisobi erozivné na povrch
terénu nebo na dno a biehy koryt vodnich tokli. Pokud zeminy nebo horniny nemohou
odolavat uc¢inklim proudéni, zacinaji se jejich jednotlivé ¢astice pohybovat ve sméru proudéni
(Vybora et al., 1989). Sedimenty jsou Vv korytech reprezentovany rtizné velkymi ¢asticemi
hornin (Tlapak, Herynek 2001).

Transport sedimenti (v Ceské literatufe nékdy oznacovano, jako pohyb splavenin)
Vv otevienych korytech je zkouman nékolik desetileti, pficemz je snaha najit co nejlepsi popis
tohoto problému. I pfesto se objevuji otazky, na které neni jednoducha odpovéd'.

Sedimenty, které se vyskytuji v toku, mohou byt rozdéleny na organické ¢i mineralni.
Organické Castice se dostavaji do toku napt. spadem listi, vétvicek ¢i umrtim organismi.
Jejich pohyb je velmi nahodny. Vétsina studii se zaméfuje na pohyb sedimenti mineralniho
puvodu (Bogardi J., 1974).

Pevné Castice mineralniho plvodu se vytvéieji erozni Cinnosti vody v povodi toku
a to smyvanim pudy a horninovych zvétralin a také v koryté¢ tokti vymildnim dna,
podemilanim a strhavanim bieht (Tlapak, Herynek, 2001).

Tvorba, pohyb a usazovani sedimentii je zcela pfirozeny proces. Tento proces mize
zvétSen intenzivngj$im vlivem lidské ¢innosti, coz miiZe mit za nasledek zménu pritocnosti
a kapacity koryta. Tyto vlastnosti mohou byt negativni napf. pii povodnich. Pfi upravach toku
je dobré se seznamit se s druhy sedimentti a zdkonitostmi jejich pohybu v korytg.

V pribéhu zkoumani chovani transportu sediment, které trvd vice nez dvé sté let,
bylo odvozeno nékolik formulaci, jez popisuji dany problém. Zatim neexistuje zadna
univerzalni rovnice, kterd by mohla byt pouzita soucasné¢ pro proudéni kapaliny
a transport Castic.

Ne vSechny formulace se hodi pro kazdy tok. Jednotliva vyjadifeni pouZivana
pro vypocet pohybu sedimenti, se lisi, a proto je diilezité mit ptehled o dalSich vlastnostech
koryta tak, aby byl zvolen vhodny model pro dany tok. Méla by se vzdy zvolit takova metoda,
ktera odpovida fyzikalné-geografickym podminkam.

K vypoctiim je potieba pfistupovat uvazeng, aby se zakladni podminky a piedpoklady

v metodach shodovaly se stavem v piirodé (Macura, Szolgay, 1990).
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Na zaklad¢ vyvinutych vyjadfeni, ktera popisuji transport sedimentd, bylo vytvoieno
nékolik pocitacovych modeli. Mohou byt 1-D az 3-D casto se K popisu transportu sedimentt
pouzivaji 1-D modely (napi. MIKE-11 od firmy DHI, HEC-RAS (diive HEC-6 od US Army,
GSTARS (vyvijen U. S. Bureau of Reclamation). Srovnani rizného softwaru uvadi ve své
praci Yang (2002).

1.1.Clile prace

Ukolem prvni &asti této prace je seznamit s vlastnostmi, po¢atkem a popisem transportu
tuhych ¢astic korytem z dostupnych literarnich zdrojt.

V druhé ¢asti je cilem sestaveni modelu transportu sedimentti v programu HEC-RAS 4.1
V zdjmovém uzemi. Hlavnim cilem prace je seznameni se s moznostmi piipravy
dat, vizualizaci a analyzou vysledkt v programu ArcGIS.

Model byl sestaven na fece Opavé z poskytnutych podkladii z Povodi Odry s.p. a Ceského
tfadu zeméméfticského a katastralniho (CUZK).

Transport sedimenti muze byt uziteCny pro zjisténi zmény povodiovych wzemi

¢1 pfi zanéaSeni vodnich dél.

11



2. Charakteristika sedimentu

K dulezitym charakteristikdm sedimentti patii velikost a tvar zrn, zrnitostni slozeni,
usazovaci rychlost a mérnéd hmotnost (hustota) ¢astic.
Dulezité rozdéleni castic ve vodnim toku je také zalozeno na tom, kde se tyto Castice

nachazeji a jak se v proudici kapalin¢ pohybuyji.

2.1.Rozdéleni sedimentu

Sedimenty se dé€li na splaveniny a plaveniny, podle toho jak se pohybuji a kde se v koryté
nachazeji (obr. 1).

zrna udrZovana ve vznosu
) turbulentnimi viry v oblasti
S / pohybu plavenin

saltujici zrna v oblasti

' 1 . l 4 pohybu dnovych splavenin

Obrazek 1 - vrozdil mezi splaveninami a plaveninami (pfednaSky Finiho inZenyrstvi CVUT, zdroj:

http://hydraulika.fsv.cvut.cz/Toky/Predmety/RIN/ke_stazeni/prednasky/8/RIN_8-1.pdf)

2.1.1. Splaveniny (bed load)

Splaveniny jsou hrubsi castice, které voda vali (kouli) ¢i posouva po dné¢ (Macura,
1981). Pohybuji a piemistuji se vzdy diskontinualné (pferuSovang), pfitom podstatné
pomaleji
nez proud vody. Maji kratce trvajici pohyb a limitovanou délku absolvované drdhy na toku.
Tento pohyb se stiida se stavem klidu a jeho obnoveni nastava jen tehdy, kdyz se vytvori

potiebné podminky opét k pohybu ¢astic (Macura, Szolgay, 1990).
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Vv koryt€ je na n¢ kladen vétsi diiraz nez na plaveniny (Zachoval, 2009).

2.1.2. Plaveniny (suspended load)

Plaveniny jsou jemné ¢astice, které jsou rozptyleny v celém pritoéném profilu. Tyto
Castice jsou trvale vodou obklopené a unasené vodnim proudem (Tlapak, Henrynek, 2001).

2.1.3. Smyv z povodi (wash load)

Brunner (2010a) uvadi jesté jednu kategorii sedimentd, ktera je v anglické literatuie
oznacovana jako wash load. Jedna se o velmi malé a jemné Ccastice plavenin, které
jsou unaseny proudem a nevyskytuji se v dnovych sedimentech. Jednad se o Castice, které
se do koryta dostavaji smyvem z povodi.

Tento sediment neni vétSinou zahrnovan do vypoctu transportu celkového mnozstvi
pratoku tuhych c¢astic.

2.1.4. Hranice splavenin a plavenin

Mezi plaveninami a splaveninami neni definovana piesnd hranice. Sir$i hranici tvofi
pisky s velikosti ¢astic vV rozmezi od 0,05-7 mm. Zavisi na hydraulické povaze vodniho
proudu a zejména na unaSeci sile. N&ktera zrna mohou byt v urcité fazi posouvana
po dn¢ a unasena proudem vody (Tlapak, Henrynek, 2001).

Castice podléhaji kvantitativnim, ale i kvalitativnim pfeméndm (napf. obrousent,
rozpadani, sedimentaci apod.). Kvalitativni zména se projevuje ve zméné zplsobu pohybu
Castice, tzn, prechodem ze splaveninového reZzimu do rezimu plaveninového (Macura,

Szolgay, 1990).

2.2. Fyzikalni popis sedimenti

2.2.1. Velikost zrn

Velikost zrn je jeden z nejvyznamnéjSich a bézné uzivanych fyzikalnich parametrd.
Je posuzovan podle rozméru zrna. Pokud by ¢astice mély tvar koule ¢i krychle ur€eni by bylo
snadné,
ale bohuzel v piirodé se takova tvarova soumérnost vyskytuje velmi ztidka (Vybora, 1978).

V tocich maji sedimenty mnoho riznych tvari od kulatych po ploché (Garde, Raju, 1977).
13



Tvarové se zrna nejvice podobaji trojosému elipsoidu s osami a, b, ¢ (obr. 2),
kde osa a je nejdelsi, b je stieni a ¢ je nejkratsi osa (Macura, Szolgay, 1990)

> X

Academy Artworks

Obrazek 2-trojosy elipsoid (zdroj:http://images.yourdictionary.com/elipsoid)

Ze znamych hodnot trojosého elipsoidu mizeme nasledné definovat velikost (prameér)
zrna. Rozdéleni je podle Macura, Szolgay (1990) :
Triaxalni pramér zrna (d)

a+b+c
3

d = (2.1)

Triaxalni pramér zrna (rov. 2.1) je fiktivni druh pruméru, ktery pomérné dobie
vystihuje tvar zrna. Pii hromadném odbéru je stanoveni triaxalniho priméru vzacné

a zdlouhavé.
Sitovy prumér zrna (ds)

Sitovy primér zrna se urcuje prosévanim na soustave sit. Je definovan jako pramér

nejmensiho oka, kterym mize ¢astice propadnout.
Geometricky primér zrna (dg)

Geometricky priimér zrna odpovida priméru koule stejného objemu, jako je Castice

o osach a,b,c. Tento primér je definovany je vyrazem (rov.2.2):

dy=3Va-b-c (2.2)
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usazovaci pramér (d,)

Usazovaci prumér se pouziva se pro charakteristiku zrn mensich nez 1 mm, Vybora
(1978) dokonce uvadi pramér zrn 0,01 mm. Je to pramér koule stejné hmotnosti, jako je dana
Castice, ktera by pfi volném padu ve vod¢ s teplotou 24 °C klesala stejnou konecnou
sedimentacni rychlosti w. Usazovaci primér se nepouziva pro hrubsi splaveniny.

Jde o metodu, kterd bere v tivahu i tvar zrna (Liu, 2001).

Pro urceni velikosti pisCitych ¢astic se pouziva metoda sitového priméru, usazovaci

pramér je pouzivan pro urceni jilovitych a prachovitych. Rozdéleni sedimentt podle velikosti

je uvedeno v tabulce 1:

Tabulka 1 - rozdéleni splavenin podle velikosti ¢astic (Tlapak, Henryek, 2001)

Kategorie splavenin Druhy splavenin Primér zrna [mm]
Balvany 500
Kameny, valouny 70-500
Hruby $térk 30-70
Posouvané — splaveniny Streni stérk 15-30
Drobny stérk 7,00-15,00
Hruby pisek 7,00-2,00
Stiedni pisek 0,1-2
Jemny pisek 0,05-0,1
Unasené — plaveniny Hruby prach (kal) 0,01-0,05
Jemny prach 0,002-0,01
Fyzikalni jil 0,000x-0,002
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2.2.2. Zrnitostni slozeni

Zrmitostni slozeni muize byt vyjadfeno ciseln¢ ¢i graficky. Jde o kvantitativni
charakteristiku procentualniho hmotnostniho podilu zrn urcitych velikostnich skupin (frakci)
na celkové hmotnosti smési v suchém stavu. Frakci nazyvame vytiidénou skupinu zrn urcité
velikosti. Hranice mezi skupinami nemaji zadny fyzikalni vyznam (Macura, Szolgay, 1990).

Zritostni slozeni se Casto znazorfiuje graficky ve formé kiivky zrnitosti,
pficemz na vodorovné ose se vynasi primeéry zrn a na svislé ose jejich procentualni podily
z hmotnosti vysu$ené smési (Macura, Szolgay, 1990).

Z pribéhu kiivky mizeme odvodit homogenitu materialu. Homogenni smési
se v piirodé nevyskytuji, jejich uplatnéni je prevazné v laboratofich (Macura, Szolgay, 1990).

K feSeni nckterych uloh je potieba sedimenty (splaveniny) charakterizovat jednou
veli¢inou. Pro tento ucel se vétSinou voli pramér efektivniho zrna de - rovnice 2.3 (Vybora et
al., 1989). Primérnym efektivnim zrnem se rozumi fiktivni stejnozrnny material, ktery bude
mit pfi stejnych hydraulickych podminkach stejny pritok sediment jako pfirozena smés

(Macura, Szolgay, 1990).

X di'pi
de = =70 (23)

kde d; je aritmeticky primér zrna a p; znamena procentualni obsah dané frakce. Piiklad
vypoctu efektivniho zrna je uveden nize.

Tabulka 2 - zrnitostni sloZeni (Macura, 1981)

di [mm] 160 80 40 20 10 5
pi [%6] 5 10 30 15 15 25
d;-p;=3375 d,= % = 33,75 mm -> yzor vypoétu efektivniho zrna

V nékterych pifipadech nemusi byt vzdy pouzity primér efektivniho zrna. Z kiivky
zrnitosti lze stanovit velikost zrna, pfi které je hmotnost vSech mensich zrn i % celkové

hmotnosti vzorku. Obvykle se uréuji hodnoty: dss,dso,dgs @ dgg(Kovar, 1988).
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2.2.3. Tvar zrn

Pfi posuzovani tvaru zrn se vychazi z trojosého elipsoidu (obr. 2) s osami a (nejdelsi), b a c
(nejkratsi). Casto se pro popis tvaru zrna pouziva tvarovy souéinitel (shape factor) popsan

nasledujici rovnici.

Cc
S.F.= = (2.4)

S.F. ... tvarovy soucinitel (shape factor)

Koule maji tvarovy souéinitel rovny 1, kdy se neznevyhodniuje zadna osa. Pro elipsy
0 pomeéru délek os 1:1:3 by mél mit tvarovy soucinitel hodnotu okolo 0,577, zrna pisku maji

prumérnou hodnotu tvarového soucinitele ptibllizné 0,7 (Sturm,2010).

Tvar zrn lze stanovit i dal$imi metodami:
e Metoda poméra hlavnich tii os (a>b>c), viz tabulka 3 (Vybora,1978)

e Soucinitel plochosti dle Cailleauxa (Macura, Szolgay, 1990)

. a+b
L= ? (25)
Tabulka 3 - Klasifikace tvaru zrn podle jejich rozméri trojosého elipsoidu (Vybora, 1978)
Pomér hlavnich rozméra Nazev
b/a >0,66; ¢/b<0,5 velmi plocha
b/a >0,66; c/b< 0,66 plocha
b/a >0,66; c/b> 0,66 izometricka
b/a <0,66; c/b> 0,66 tyCinkovita
b/a <0,66; c/b< 0,66 plocha ty¢inkovita

2.2.4. Obrus zrn

Zrna se pii pohybu po dné rozpadavaji, obruSuji a tim se zmenSuje jejich velikost

a hmotnost. Postupné zrna ziskavaji tvar elipsoidu. Castice vyvielych a metamorfovanych
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hornin se pii obruSovani blizi svym tvarem vice kouli, nez zrna z flySovych oblasti (Macura,
Szolgay, 1990).

Velikost obrusu pii daném petrografickém slozeni materialu vykazuje zavislost
na draze, na niz doslo k ubytku hmotnosti (Vybora et al., 1989). Tomuto problému se vénoval

H.Sternberg (1875), ktery jej popsal nasledujici rovnici:

dG = —c-Gy-ds (2.6)

dG

E = —C- GO (27)
G dG

~Jp 5 =—clyds (2.8)

Po integraci pii poc¢ate¢nich podminkach (s =0, G =Gy) dostaneme nasledujici vztah:
G=0Gy- e “? (2.9)

Gp .... hmotnost zrna na zacatku drahy
G .... hmotnost zrna na konci vykonané drahy
ds .... zména drahy

C ... soudinitel obrusu — coefficient of abrasion

Soucinitel obrusu c je ubytek castice o hmotnosti 1kg na draze 1 km (tabulka 4).
Mgéfenim bylo zjisténo, 7e hodnoty soudinitele obrusu ¢ lezi mezi 0.003 kgkm™
a0.03 kgkm™.

Vzdalenost, kterou musi zrna urazit, aby se zmensila na polovinu je pro jednotlivé
druhy hornin nasledujici:

Amfibolit 200-250 km; kiemen 140 km; zula a rula 100-150 km; dolomit 60 km:;
slin 30km.
Zrna se nikdy nezmens$i na nulovou hodnotu, ale pouze do ur€ité velikosti, po té€ jsou

unaSena jako plaveniny (Kovat, 1988).
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Tabulka 4- hodnoty sou¢initele obrusu ¢ (Vybora et al.,1989)
Soucinitel C

Hornina
Zaoblena zrna Ostra zrna

Kvarcit (kfemen) 6,97:10™

Zula 2,2510°=0,510" 8,56'10°°
Rula 2,2510°

Dolomit 2,5710° 5,42107
Amfibolit 2,8810° 5,0710°
Viépenec 8,7810°%=1,59.10" 5,07:10%
Piskovec 4,12°10-2 4,4310™

2.2.5. Mérna hmotnost, mérna tiha

M¢érnd hmotnost sedimenttli ps se definuje jako pomér hmotnosti ¢astic k jejich objemu,
jednotkou je kgm,
V nékterych vypoctech je uvaddéna mérna tiha splavenin, kdy je mérna hmotnost
vynasobena gravita¢nim zrychlenim (rov. 2.10).
Ys= Ps*Q (2.10)
Jednotkou mérné tihy je N'm™ = kg.m2.s? (Macura, Szolgay, 1990).
V tabulce 5 jsou uvedeny hodnoty mérné hmotnosti a tihy nékterych druhii ¢astic. Casto se

pouziva univerzalni hodnota, ktera je v tab. 5 uvedena pro §térky a pisky.
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Tabulka 5 - hodnoty mérné hmotnosti a mérné tihy riznych druhi sedimenti (Macura, Szolgay, 1990)

Ps Ys
Druh splavenin ; N'm3=
kgm kgm?s?

Stérky, pisky 2650 26500
Prachovité pisky,

piscité hliny 2070 20700

Prachovité hliny 2700 27000

Jilovité hliny, jily 2750 27500

2.2.6. Sedimenta¢ni rychlost

Sedimentacni rychlost w (fall velocity) je dulezita charakteristika sedimentd, ktera
se pouziva v transportnich rovnicich. Jedna se o funkci vlastnosti materialu (d, ps, Q)
a kapaliny (p, p). Vztah sedimentaéni rychlosti (rov.2.16) v klidné kapalin¢ jako prvni
zveiejnil Sir George Stokes v roce 1851. Stokes piedpokladal kulovy tvar castice.
Pti rovnomérném pohybu télesa v kapaliné bude odpor télesa (Fp, rov. 2.11), ptisobici proti
pohybu, v rovnovaze (rov. 2.15) s tihou télesa (Gs, rov. 2.14) (Vybora et al., 1989). Tiha

télesa je rozdilem sily gravitaéni (Fg, rov. 2.12) a sily vztlakové (Fg, rov. 2.13).

.d3

Fp=3-m-d-pu-ws (2.11) FG=”6 “Ps* g (2.12)
.d3 .d3
Fp="—-py-g (213)  Fg—Fz =Gy ="—-(ps—py) - g (214)
.d3 s— P .d?
3omdpws =T (pmpy) g (215)  wy =R O (2.16)
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Obriazek 3 - sily piisobici na klesajici &astici v tekuting ((pfednasky Fi¢niho inZenyrstvi CVUT, zdroj:
http://hydraulika.fsv.cvut.cz/Toky/Predmety/RIN/ke_stazeni/prednasky/8/RIN_8-1.pdf))

Platnost vztahu (rov. 2.16) je omezena hodnotou Reynoldosva ¢isla (Re) (rov.2.17).
ktera musi byt mensi nez 0,1.

R, =2 (2.17)

v

Pro vétsi hodnoty Reynoldsova ¢isla byly odvozeny pozdéji dalsi vztahy, vétSinou
charakterizujici kulové castice. Zrna v tocich budou mit rychlost odliSnou, protoze maji
vétSinou jiny tvar neZ kulovity (Vybora et al., 1989).

Zpracovani rovnice 2.16 graficky i s vlivem tvaru je na obrazku 4.

g Qe
g ;J.—;a’
o t a‘:*’t"'f:ﬁi’”'*—%y— / A
= = = ——— =
*E fowmde T o —
4 2 ws000 kg /o 4! ! '_‘lg“-l/,{(v al !
| 777
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; 2 C Je najkratdl; o jo neieiS)) b e atfeciv osa 2| ————-* . /,/f /’/ .t i -
- + navesiom koimych o8 2ene ’ /.-"/ / 7
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Obrazek 4 - sedimentacni rychlost zavisla na priméru ¢astic (Kovar, 1988)
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Zahrnutim tvaru ¢astice se zabyval Heywood, ktery vyvinul jednoduchou grafickou
metodu, jez urcovala vliv tvaru zrna na rychlost sedimentace a zavedl vyraz pro odporovy
soucinitel (Cp) pomoci konstantniho objemu K (rov. 2.18) (Sturm, 2010 ex Heywood 1962).

objem castice

K = =

(2.18)
:8'K.(ps_p).g'd

C
b T p w?

(2.19)

Pokud se do rovnice pro odporovou silu (2.11) dosadi odporovy soucinitel (2.19),

jez bude v rovnovaze s tihou télesa (2.14), 1ze vyjadiit sedimentaéni rychlost vztahem (2.21).

1 1 -d?
FD=E.pv.CD.A.U2=E.pU.CD.nT.WSZ (2.20)
— |2.Psmpv) gd
W, = \/3 e (2.21)

Tato rovnice plati, kdyz jsou hodnoty Re ¢isla v rozmezi 0,1 az 500. Rovnice 2.21
nejde fesit explicitné prave proto, Ze je odporovy soucinitel funkci Re ¢isla Cp=f(Re) (Sturm,
2010). Je proto vyzadovana aproximace Reynoldsova ¢isla ¢i odporového soucinitele nebo

iterativni feSeni (Brunner, 2010a)

3. Vliv sedimentii na koryto toku

Dokud jsou sily plsobici na dno koryta mensi neZ jejich mezni hodnoty, je material
na dné koryta v klidu a dno je mozné povazovat za stabilni. Jestlize ale dosdhne te¢né napé&ti
kritickou hodnotu, nebo ji piekroci, zacind pohyb castic (Mares, 1985).

Casto je problém definovat pocatek pohybu. Kramer v roce 1965 definoval tfi typy
pohybu (Mares, 1985 ex. Kramer, 1965):

e Slaby — jen né€kolik ¢astic se pohybuje. Pohybujici se zrna maji proti ostatnim zrntim

malé primery.

22



e Stfedni pohyb — =zrna stfedniho praméru se zacinaji pohybovat. Pohyb

uz neni jen lokalni, nelze stanovit poCet zrn na jednotku plochy. Zatim

na dné nenastavaji zadné vétsi deformace.
e Hlavni pohyb — pohybuje se celd splaveninova smés na dné.

Pti pohybu castic vznikaji plaveniny a splaveniny, ¢imz se méni nékteré vlastnosti
koryta. Dochézi k ptetvareni koryta, kdy se formuje pticny, ale i podélny profil. Koryto
se prohlubuje, zaktivuje a rozsituje (Vybora et al., 1989).

Transport sedimentli ovliviiuje rychlost proudéni, coz lze vyjadfit v nasledujicich
rovnicich 3.1 a 3.2. Rychlost proudici vody s nerozpusténymi tuhymi c¢asticemi je mensi
nez rychlost vody samotné. Oznacime-li V jako objem Cisté vody a splavenin a V1 jako objem

pouze splavenin, pak celkova hmotnost vody a splavenin bude:
M=WV-V)-p+V;-ps (3.1)
Piedpokladem je stejna hodnota hybnosti ¢isté vody a vody se splaveninami.
Vep-v=I[V—=V) p+Vi-pgl-vg (3.2)

V ... je prafezova rychlost Cisté vody

Vs ... prufezova rychlost vody a splavenin

Pokud si vyjadiime vs dostaneme:

p
v, =v—>Pt (3.3)
T p—e-ps)

Jelikoz p<ps a V1<V, je zfejmé, Ze hodnota zlomku je mens$i neZ jedna a proto musi
byt ve<v (Vybora et al., 1989).

K ukladani castic dochazi v mistech, kde kles4 unaSeci schopnost proudu, sedimenty
se usazuji a vytvareji rizné zrnitostni slozeni a tvary na dn¢ (Vybora et al.,1989).

Mnozstvi splavenin v tocich se velmi rizni podle geologickych, pedologickych,
morfologickych a jinych podminek v povodi i ve vlastnim koryté&, jakoZ i podle hydraulickych
vlastnosti toku. Pritok splavenin se vyjadifuje se specifickym pritokem splavenin,
coZ je mnozstvi, které projde korytem toku o §ifce 1 m za 1 sekundu (kgs™m™). Znalost
pratoku splavenin je dualezita pro feSeni TUprav tokii 1 rGznych navrhovanych

vodohospodarskych zatizeni a staveb (Tlapak, Henrynek, 2001).
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3.1. Pocatek pohybu splavenin

Je t€zké urcit pocatek pohybu sedimentli. Vice méné zélezi na definici jednotlivych
autort (Yang, 2006). Nejdiive se zatnou pohybovat vy¢nivajici ¢astice a pii vétSim pritoku
se do pohybu davd vice a vice splavenin. Pohyb nejdiive zaclina pieklopenim
¢1 posunem, pii zvySeni rychlosti dochazi k véleni ¢i kouleni po dné, které piechazi
vV poskakovani nebo unaSeni c¢astic proudem. Nekteré vySe uvedené stavy nastat nemusi.
Zalezi jak na vlastnostech proudici tekutiny, tak na vlastnostech ¢astic, které jsou prenaseny
(Kolat, 1978).

Pfi ur€ovani zacatku pohybu splavenin se vytvotily urcité zjednodusené predstavy
o pusobeni proudiciho média na materidl tvofici dnové sedimenty. Na castice pusobi sily,
které se snazi uvést Castice do pohybu. Teorie, které¢ se zabyvaji popisem pocatku pohybu
splavenin, jsou zalozené bud’ na kritické rychlosti proudu - vymilaci rychlost (velocity

approach) nebo na kritické unaseci sile proudu - te¢na sila na dné (shear stress approach) .

3.1.1. Kriticka rychlost proudu

Kriticka rychlost proudu je tzv. nevymilaci rychlosti proudu (vy). Sily pusobici
na ponofenou ¢astici na dné jsou v rovnovaze a tim je branéno v pohybu ¢astic. Pokud tato
rychlost neni pfekrocena, pak nedochdzi k naruSeni stability dna (Vybora et al., 1989).
Jde o maximalni hodnotu rychlosti pfi rovnomérném pohybu (Kolat, 1978).

Sily pasobici na ponofenou castici jsou znazornény na obrdzku 5: titha ponofené
castice (Fg; rov. 3.6), hydrodynamicky tlak (rov. 3.4) a hydrodynamicky vztlak (F; rov. 3.5)
(Mares, 1985).

»
uh

Obrazek 5 - Sily pisobici na ¢astice na dné (Graf, 1971)
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FD=CD'k1'd2'p‘Tu2 (34)

FL=CL'k2'd2'p.Tu2 (35)

FG=G=k3‘(PS_P)'9'd3 (3.6)

Cpb ... odporovy soucinitel

C. ... vztlakovy soulinitel

d ... primér zrna

k1, k2, k3 ... tvarové soucinitele

u ... rychlost vody u dna

Nevymilaci rychlost se vyjadiuje ze vztahu (3.7), kde uhel ¢ vyjadiuje ptfirozenou sklonitost
materialu a thel a je sklon dna, pfi némz zacina pohyb castic.

G - sina + Fp

99 = G -cosa —F, 3.7)
Po dosazeni rovnic 3.4 a 3.5 do rovnice 3.7 a Gprave rovnice, dostaneme vyraz:

uz, _ 2-ks(tgy - cosa — sina) 38)
(%_1),g,d CD‘k1+CL'k2‘tga '

Pravou stranu rovnice zapsat jako koeficient A, ktery v sobé zahrnuje vlastnosti ¢astic
(tvar, velikost, zrnitostni slozeni atd.), dynamiku proudu (ma vliv na koeficienty Cp a C),
sklon dna a sklonitost vnitiniho Uhlu sedimenti na dné (Graf, 1971). Tim padem muze

byt rovnice kritické rychlosti zapsana nasledovné:

ukr=\/A-(%—1)-g-d (3.9)

Existuje nékolik experimentalnich formulaci (napf. od F.J. Mavise, Goncarova, Leviho
atd.), kteti popisuji kritickou rychlost proudu a jsou zjednoduSenim rovnice 3.9. Parametry

téchto vyjadieni byly vétSinou urCeny bud’ laboratornimi pokusy ¢i pfimym meéfenim
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na tocich (Bogardi, 1974). VétSinou tyto vzorce nemaji vSeobecnou platnost a lisi
se ve vysledcich (Kovar, 1988).

V roce 1935 popsal Hjulstrom graficky vztah mezi rychlosti a primérem zrna (obr. 6).
K popisu pouzil primérnou rychlost proudu a piedpokladal, ze primérnd rychlost

je asi 40 krat vétsi nez rychlost u dna pro hloubku vétsi jak 1 m (Graf, 1971).
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= o
s "
[ 7
Transport Depaosition
1 w4
'l
0,1 Vi
— — — —_ [ = =
5 = o o = = =
= Grain size [mm] -

Obrazek 6- eroze -transport- sedimentace ¢astic podle Hjulstroma (Graf, 1971)

3.1.2. UnaSeci sila proudu

Vyznamny a Siroce pouzivany pfistup ke stanoveni pocatecniho pohybu castic
je diagram Shieldse z roku 1936 zalozeny na te¢ném napéti (t). Shields ptedpokladal,
ze faktory popisujici pocatek pohybu castic jsou te¢né napéti (t), rozdil hustot mezi
sedimentem a tekutinou (ps — p ¢i ys —y), rozmér Castice (d), kinematicka viskozita (v)
a gravitacni zrychleni (g). Vztah mezi proménnymi v Shieldsové rovnici (rov. 3.10) byl urcen
experimentalné. Vysledky jsou uvedeny v grafu (obr. 7), kde jsou zahrnuty vysledky dalsich

autortl. Prostor nad ktivkou urcuje, ze se ¢astice bude pohybovat a naopak (YYang, 2006).
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s _Ty) —=f (uv d) (3.10)

Tc ... kritické tecné napéti na dné
Y, Vs ... mérnd hmotnost vody, ¢astice (vypocet rovnice 2.10)

v ... kinematicka viskozita (v=p/p; dynamicka viskozita/hustota vody)

Leva strana rovnice 3.10 je tzv. Shieldsiv parametr (0) a prava strana rovnice 3.10
je funkci Re Cisla, které se znaci jako Rexa nazyva se splaveninové Reynoldsovo Cislo.
Tteci rychlost (ux) vyjadiuje rovnice 3.12 a kritické te¢né napéti () je definovano

vyrazem 3.11.

7,=y-R-S (3.11)
t
u, = ;Céi u,=+/g-SR (3.12)

R ... hydraulicky polomér
S ... sklon

=94

Obrazek 7 - Shieldsiv diagram (Graf, 1971)
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Na obr. 7 mizeme rozlisit tfi hlavni oblasti: lamindrni, pfechodnou a turbulentni.
Urceny jsou piibliznou hodnotou splaveninového Rex ¢isla, nebo porovnanim tloustky

vizk6zni podvrstvy (9, rov. 3.13) a primérem zrna (d) (Graf, 1971).

__116-u
§ == (3.13)

RozliSeni oblasti:

a) Laminarni (Re«=2;d< 9)

Castice jsou uzavieny laminarnim filmem, jejich pohyb je vyhradné zptsobovan
viskéznim ucinkem a nezévisi na turbulenci. Podminky proudéni jsou podobné pohybu

tekutiny omezené hladkymi sténami (Graf, 1971).
b) Prechodna (Re-=10;d= )

Laminarni podvrstva z ¢asti pokryva splaveninové ¢astice a z Casti je preruSena. Podle

Shieldsova diagramu tomuto ptipadu odpovida Shieldstv parametr.
= — < =003 (3.14)
(ys=v)-d 7 '

Pod touto hodnotou by nemélo k pohybu castic dochazet (Graf, 1971).

c) Turbulentni (Re->500;d>6)

Dochéazi k poruseni laminarni podvrstvy drsnosti dna, kterd je zdrojem turbulence.
Shieldstiv parametr by mél byt roven:

6 =0,06
Hodnota mtze byt i nizsi okolo 0.047 (Graf, 1971).

Shieldstiv diagram se stale Siroce pouziva K ureni popisu, zacatku pohybu dnovych
castic. Vpraxi dochazi k upravam kiivky v zavislosti na mistnich podminkach,

ale vétSinou jsou zmeny nepatrné.
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3.2. Dnové utvary

Splaveniny se pohybuji po dné jednotlivé nebo ve dnovych utvarech, které se rozdéluji
na rovné dno, vrasky (Cefiny), duny, lavice a antiduny (obr. 8). Existence dnovych splavenin

je zavisla na Froudové Cisle (Fr; rov. 3.15) (Kolat, 1978).

Fr =

(3.15)

a

Pti pohybu dnovych tutvari se méni charakteristiky sedimentl (zrnitostni sloZeni)
a charakteristiky proudu (napf. mnozstvi plavenin v proudu, rychlost). Se zménou tvaru
dna se méni také vodni hladina (Garde, Raju, 1977).

Kromé¢ zakladnich typli dnovych utvariit mohou existovat riizné mezitypy. V pfirozenych

korytech mohou rizné dnové ttvary existovat vedle sebe ¢i za sebou (Kolar, 1978).

3.2.1. Rovné dno (plane bed)

Nastava v ptipadech, kdyz neni ptekro€ena kriticka rychlost uc (resp. kritické te¢né napéti
t¢), tudiz nedochézi ani k pohybu splavenin po dn¢ (Garde Raju, 1977).

Druhym piipadem, kdy se miize objevit rovné dno, je pfechod mezi dunami a antidunami.
V tomto ptipadé se Froudovo ¢islo pohybuje v rozmezi 0,7 -1 a dochazi k pohybu splavenin
(Pato¢ka, Macura, 1978).

Pokud se vyskytuji rovné dno, nedochazi k narusovani vodni hladiny (napf. viny, viry...).

3.2.2. Vrasky (Cefiny, ripples)

Vrasky jsou vétSinou slozeny zjemnozrnného materidlu S primér zrna mensimi
nez 0,6 mm. Vrasky se podobaji vinkam, které¢ maji trojuhelnikovity tvar, maji vinovou délku
pod 60cm a vysku do 6 cm (Patoc¢ka, Macura, 1978).

Pohybuji se po proudu rychlosti mensi nez prufezova rychlost proudu. Nijak neovliviiuji
vodni hladinu, ale vznik vrasek ovliviiuje drsnost a tim i prutok splavenin a plavenin v toku
(Kovat, 1988).
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3.2.3. Duny (dunes)

Duny vytvareji podobny tvar jako vrasky s mirnym sklonem proti proudu. Po proudu
odpovidd sklon pfirozenému sklonu materialu. Objevuji se pii vysSich pritocich vody
a splavenin nez vrasky. Pfi menSich priitocich se na svazich dun mohou z jemnozrnného
materidlu vytvaret vrasky. Pohybuji se po proudu. Vznikaji, kdyz je Fr < 0,6 (Patocka,
Macura, 1978).

Mohou ovliviiovat hladinu toku. VIiny na vodni hladiné maji jiny prabéh nez duny (Kolaf,
1978). Duny mohou ovliviiovat i hloubku. Pfi vysSich rychlostech duny rychle rostou,
nejmensi hloubka je na hiebenu duny, kde je i nejvétsi rychlost vody. Nasledné miize
byt duna smyta a mize byt vytvoreno rovné dno ¢i jiny tvar (Liu, 2001).

3.2.4. Lavice

Lavice se tvoii podobné jako vrasky ¢i duny, ale jsou z hrubozrnnéjSiho materidlu
s malym obsahem jemnych castic. Jejich pohyb po proudu je rychlejsi nez u vrasek a dun.
Splaveniny se nejvice pohybuji v ¢ele lavice, pak se pohyb postupné zmensSuje a na konci
témet ustava. K naruSovani lavic dochazi pti vysSich rychlostech, kdy dochazi k odtrhdvani
nékterych castic a naslednému ukladani na nasledujici lavici (Kovar, 1988).

3.2.5. Antiduny (antidunes)

Antiduny jsou dnové utvary, které se vytvari pii Fr> 0,8. Mohou se pohybovat po proudu,
proti proudu ¢i stat na misté. Chovani antidun, zavisi na vlastnostech splavenin a podminkach
proudéni (Patocka, Macura, 1978). Pohyb antidun probiha, kdyz na nab&éhové strané poklesne
te¢né napéti, dochazi na ni k ukladani splavenin. Na opacné stran¢ ke strané nab&hové se
splaveniny vymilaji (Kovar, 1988).

VInova délka (L) je urcena rovnici 3.16, vySka zavisi na hloubce a rychlosti vodniho
proudu.

172

A=2-m-— 3.16
7 (3.16)

Hladina je vyrazné sfazovana se dnem a symetrické viny urcuji pfitomnost antidun. Viny
s rostoucim Fr Cislem rostou, az ztrati stabilitu a rozpadnou se smérem proti proudu (Kolaf,

1978).
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3.2.6. Kryci vrstva (pFirozena dnova dlazba)

Vlivem nepravidelného pohybu splavenin dochazi ke tfidéni materidlu a dochazi
ke vzniku tzv. kryci vrstvy, kdy se splaveniny v horni vrstvé uloZi tak, Ze vzdoruji odplaveni.
Vétsinou se splaveniny ulozi Supinovité. Dno chranéné kryci vrstvou se dd do pohybu

az pti znacné vyssim pritoku (Kovar, 1988).

vrasky

O NI T W Ve e

antiduny antiduny s pireklipéjicimi se vinami

Obrazek 8- tvary na dné (pfednasky Fi¢niho inZzenyrstvi CVUT,
zdroj:http://hydraulika.fsv.cvut.cz/Toky/Predmety/RIN/ke_stazeni/prednasky/8/RIN_8-1.pdf)
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4. Prutok sedimentu

K pohybu sedimentii v koryt¢ bylo odvozeno nékolik formulaci, jez lze rozdé¢lit
na pritok splavenin (¢astice na dné), pritok plavenin (vznasSejici se ¢astice) i celkovy priatok

sedimentli. Metody vznikly za urc¢itych podminek, které vymezuji rozsah jejich pouziti.

4.1.Pritok splavenin (bed load)

Rovnic, které popisuji pohyb splavenin u dna, bylo vyvinuto n¢kolik, casto
podobné. Rovnice byly proto rozdéleny podle typu do tii skupin (Graf, 1971):

DuBoysuv typ rovnic, ktery je zaloZen na vztahu tecného napéti (to) a kritického tecného
napéti (Tor)

Prvni rovnice, kterd se vénovala transportu dnovych splavenin, byla odvozena DuBoysem.
Po té¢ ho nasledovalo né€kolik dalSich, vétSinou vychazeli z jeho ptedpoklad (Garde, Raju,
1977).

Duboys predpokladal, ze odnos splavenin nastava v n vrstvach (obr. 9) s tloustkou h,
které jsou rovnobézné ke dnu. Rychlost ve vrstvach je riznd, zrna v povrchové vrstvé
se pohybuji rychlosti (n-1)Av, kde Av je pfirtstek rychlosti mezi spodni pfilehlou vrstvou
a horni vrstvou. Pokud je rychlost mezi vrstvami rozlozena linearné, pak je pritok splavenin

dan rovnici 4.1 (Graf, 1971):

‘n(n—l)

qs = h-Av > (4.1)
dno w ——=
= N (o-1)- Av | T
(0-2)-Av |

Obrazek 9 - proudéni splavenin na dné dle DuBoyse (Graf, 1971)
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fv v

(rov. 4.2). Pokud ale dojde k naruSeni rovnovahy, pak te¢né napéti piekro¢i mezni hodnotu
a dojde k pohybu splavenin (4.3).
To=Y Dp-S=c¢n-h-(ys—v) (4.2)
Tokr =€ h- (s —7) (4.3)
Cs...koeficient tfeni
Pokud se rovnice 4.2 a 4.3 daji do poméru, vyjde vyraz pro pocet vrstev n= To/ Tokr

a vlozenim a upravou rovnice 4.1 dostaneme nasledujici vyjadfeni (DuBoysova rovnice)

(Graf, 1971):

h-Av
qs = > ] *Tp - (To - TOkr) (4.4)
*Tokr
[ h-Av ] 4.5)
X= .
2- Tokr

x... kvantitativni charakteristika sedimentd (splavenin)

Schoklistchiiv (1934) typ rovnic, ktery je zaloZen na vztahu pratoku kapaliny a kritického
te€né¢ho napéti, pfi némz se splaveniny zacinaji pohybovat.

Schoklistch pomoci laboratornich experimenti dosel k vyjadieni pritoku splavenin
podobnou rovnici jako DuBoys, pfi¢emZ tecnou silu (to) nahradil pratoky (q). Jedna
se o zékladni rovnici, kterd byla ndsledn€ riznymi autory upravovana. Tyto rovnice jsou proto
popisovany jako Schoklitschiv typ rovnic.
as=x -S* (@~ qur) (4.6)

x"... koeficient popisujici charakteristiku sedimentt (splavenin)

Mezi tento typ rovnic patii empiricky vztah, ktery vyvinuli a v roce 1948 publikovali
Mayer-Peter a Miiller. Vyjadfeni ziskalo oblibu v technické praxi (Vybora et al., 1989).

Autofi predpokladali, ze sklon ¢ary mechanické energie (S) je urCujicim parametrem
pohybu splavenin. Cast mechanické energie patii pohybu splavenin a &ast pohybu vody
(Vybora et al., 1989).Rovnice vyjadiuje vztah mezi primérnym te¢nym napétim, které plisobi
na ¢astice a kritickym te¢nym napétim, které zplisobuje transport splavenin. Jako obecny tvar

se uvadi (Brunner, 2010a):
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(_’>3/2 Y R-S=A-(e—y)-d,+B- (3)1/3 . (ys;)/>2/3 . g (4.7)

kr ...drsnost dna (makrodrnost)

kr’...povrchové drsnost vyvolana zrnem (mikrodrsnost)

R ...hydraulicky polomér

gs ...hmotnostni pritok splavenin na jednotku §ifky koryta

A, B ... experimentalni soucinitelé (A=0,047; B=0,25)

Vztah je zalozen na experimentech piedpokladajici rovné dno s ¢asticemi pisku a Stérku.

Vhodné rozmezi zrn je od 0,4 mm do 29 mm (Brunner, 2010a).

Einsteintv (1942) typ rovnic, ktery je zaloZen na statistickém vyjadreni sil vztlaku.

Einstein, jenz vychazel z experimentalnich poznatki DuBoyse a Schoklitsche, dospél

ke dvéma zakladnim mySlenkam:

(1) Stanoveni kritickych hodnot pro pocate¢ni pohyb splavenin je velmi obtizné a
skoro nemozné. Proto je vhodné se témto myslenkam vyhnout.

(2) Pohyb splavenin zavisi vice na fluktuaci turbulentniho proudéni nez na stfednich
hodnotéch sil proudéni piisobicich na castice. Tudiz lze chéapat zacatek a konec
pohybu
jako pravdépodobnostni jev, ktery je zavisly na vztlakové sile a tize splaveniny
pod vodou (Graf, 1971).

Einstein svou experimentalni praci ukond¢il t€émito tezemi:

Ustalend a intenzivni vymeéna Ccastic existuje mezi pohybujicimi se splaveninami

a dnovym materialem.
Pohyb probihd v krocich, kdy stfedni délka téchto krokii je iimérna velikosti Céstice.
Castice nezlistavaji v souvislém pohybu, ale po néjaké dobé se usazuji (Vybora et al., 1989).
Svou rovnici se Einstein snazil vyjadfit podminku rovnovahy vymény dnovych splavenin
mezi pohybujici se vrstvou a dnem (rov.4.8) s tim, Ze pocet ¢astic usazenych za jednotku ¢asu
na jednotkové plose (leva strana rov. 4.8) musi byt rovny poctu erodovanych ¢astic

za ¢asovou jednotku z této jednotkové plochy (prava strana rov. 4.8) (Kolafr, 1978).
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Vysledna Einsteinova rovnice ma tvar:

9s *Pa __ b ps—p)-g
ps'g'AL'kv'd4 ks'kt'd2 p

(4.8)

Os... hmotnostni mérny pratok splavenin

P4 ... hmotnostni procento frakce dnovych splavenin
Po ... hmotnostni procento frakce materialu dna

AL ... soucinitel délky kroku ¢astice

P ... pravdépodobnost, ze dojde k vymleti ¢astice
Ks ... konstanta plochy ¢astice

Ky ... konstanta objemu ¢astice

k: ... konstanta ¢asového méfitka ¢astice

Einstein zavedl bezrozmérné ¢islo, které nazval intenzita pohybu dnovych splavenin (¢).

_ 9 p
ps g |(ps—p)-g-a3

¢ (4.9)

4.2.Priitok plavenin

Plaveniny jsou ¢&astice, které jsou obklopené vodou, ptemistované v suspenzi. Pokud jsou
sily udrzujici ¢astici v suspenzi mensi nez tiha ¢astice, dochazi k jejimu poklesu.

Mnozstvi plavenin se udava bud’ jako koncentrace pevnych latek (pocet pevnych ¢astic
na objem), nebo jako pritok plavenin oznacujici mnozstvi pevnych latek transportovanych
danym pfiénym profilem za jednotku casu. Prutok plavenin na Im $iiky se oznacuje jako
meérny priitok (Vybora et al., 1989).

Plaveniny ziistavaji v proudu, pokud svisla slozka turbulence je vétSi neZ usazovaci
rychlost (w). Pevné Castice maji podobné drahy, jako castice vody. Meéni se mnozstvi
a zrnitostni slozeni plavenin (Vybora et al., 1989).

K pohybu ¢astic v suspenzi dochazi, pokud vertikalni slozka turbulence (leva cCast
rov. 4.10), kterd vzna$i Castice vzhuru a slozka, obsahujici usazovaci rychlost (prava ¢ast

rov. 4.10), jsou v rovnovaze (Garde, Raju, 1977).
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dc
dy

D ... soucinitel difuzivity

D —w-C (4.10)

C ... koncentrace splavenin v hloubce y

Rovnice 4.10 je diferencidlni rovnici pro distribuci plavenin ve vertikdlnim sméru.
K ziskani relativni distribuce je potfeba ji integrovat v mezich mezi hloubkou y a hloubkou a
(obr. 10) (Kovaft, 1988). Po integraci a upravé je ziskan vztah (4.11) koncentrace plavenin

Mo L

¥
kisivke rord@len]
koncentrace plavenin

Cy Obr. 3-8

Obrazek 10 - kiivka rozdéleni koncetrace plavenin (Kovafr, 1988)

C _ pmwo-ayp (4.11)
Ca
Pokud zname vertikalni sloZzeni sedimentti v toku, mizeme vypocitat prutok plavenin

(rov.4.12).

h
gpzps-fC-u-dy (4.12)
0
Koncentrace Rychlosti Priitok plovenin
) = e =
..._.c~ ..II |.1n. I I Tﬂ;‘_ t
| ‘ ) =3 2
| % -
\céa R = LR R
e

Obrazek 11- vertikalni distribuce plavenin, rychlosti a pritoku plavenin (Kovar, 1988)

4.3.Celkovy pritok sedimentu

Celkovy prutok sedimentli je obvykle soucet mnozstvi plavenin a splavenin. Pti nizsich
rychlostech, kdy se sedimenty pohybuji pfi dné, je mozné pouzit aproximované rovnice

pro vypocet pritoku dnovych splavenin.
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Garde,Raju (Garde,Raju,1977) a Graf (Graf,1971) rozdé€luji dva pfistupy, které
se zabyvaji stanovenim celkového pritoku splavenin — nepfimy a ptimy.

Prvni pfistup je nepiimy, kdy v celkovém prutoku splavenin je zahrnut i smyv materialu
z povodi, ktery se v koryté vyskytuje jako tzv. wash load. Timto pfistupem se napt. zabyval
H.A.Einstein (Graf, 1971).

P.B.Toffaleti by jednim z autorl, ktery zalozil svou metodu na Einsteinové piistupu.
Rozdélil vertikalni distribuci suspendovanych castic do Ctyf vrstev: horni, stfedni, dolni
a dnova vrstva. V kazdé vrstvé je vypocitan pritok sedimentii nezavisle na sobé€, celkovy
pratok je souctem ze vSech Ctyr vrstev. Ve vyjadieni je zahrnuty vztah mezi charakteristikami
sedimentll a hydraulickymi charakteristikami. Vhodna velikost ¢astic je v rozmezi 0,3-0,93
mm, metoda vede k uspokojivym vysledkiim i pro Castice praimérem zrn okolo 0,095 mm
(Brunner, 2010a).

Toffaletiho rovnice transportu sedimentl v jednotlivych vrstvach:

1+1y—0,756-2

( i ) — (2-d,)tTw0756z

11.24 ,
Jsep = M - 5 n —0756 2 dolni vrstva (4.13)
R 1+ny—0,756-z R\1tnw—z R 1+ny-z
_ (11.24) _[(E) _(11,24) ] v ;
Jses = M - stredni vrstva (4.14)
1+ny—z
R 0.244-z R 0.5z ny—1,5-2 R 1+ny—1,5-z
_y mm G G ) ] horni vrst 4.15
Gsen = rPe—y orni vrstva (4.15)
Jseg = M - (2 - d,)tHw=07562 dnova vrstva (4.16)

M... parametr koncentrace sedimentl
Z....exponent popisujici vztah mezi vlastnostmi sedimentu a hydraulickymi
charakteristikami

Ny... exponent teploty

Druhy piistup je ptimy, kdy pfedpokladem je, Ze pii urcovani celkového pritoku
sedimentll je materidl v koryt€ zadsobovan materidlem dna (Graf, 1971).

V tomto pfistupu je zahrnut vztah k tenému napéti (Garde, Raju, 1977). Existuje mnoho
vyjadieni, kterd jsou zalozena na tomto pfistupu. Nasledné je popsano nekolik funkci

od riznych autorti, ktefi tento problém fesili.
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a) Laursen - Copeland

Laursen uvazoval, ze dilezitymi parametry, které popisuji celkovy pritok, jsou pomér
tieci rychlosti (u~) k sedimentacni rychlosti (w), velikosti zrna (d) k hloubce (Dy), koncentrace
splavenin (C) a te¢ného napéti (to) ke kritickému te¢nému napéti (toxr) (Garde, Raju, 1977).
Pozdé¢ji tuto rovnici zobecnil Copeland, ktery do rovnice zahrnul i transport Stérkovych
sedimenttl.

Rovnice sestavend Laursenem, meéla hranici priméru zrmn od 0.011 — 4,08 mm
(Garde&Raju, 1977). Po upravé Copelandem je mozné pocitat v rozmezi od 0,011 — 29 mm
(Brunner,2010a).

Laurensova rovnice upravend Copelandem:

7/6.<T0 —1)f(E) (4.17)

Tokr w

de
Cm = 0,01 Y (D—>
h

Cm... prutok koncentrace sedimentti (vdha/objem)

Dy... efektivni hloubka
b) Engelund - Hansen

Tito autofi navrhli, ze celkovy pritok sedimentd, je ve vztahu k tecnému napéti a téeni
na dné. Predpokléadali, Ze dno je pokryto dunami, pohybujici se po proudu, jenz neméni tvar
(Garde, Raju, 1977). Tento ptistup je vhodny pro koryta, ktera maji hlavné piscité slozeni
S podstatnym mnozstvim suspendovanych ¢astic. Rozmezi priméru zrn, pro které je mozné

pouziti: 0,19 — 0,93 mm (Brunner,2010a).

dso ) [ To
(Y — —y)-d
g (y 1) 105 =¥) - dso

]3/2

Jse = 0,05 -y, - U? - (4.18)

U...pramérna rychlost proudu
c) Ackers - White

Ptedpokladem téchto autort bylo, Ze jen tecné napéti na dné je podminkou k transportu
hrubého materialu a jemny material je dominantni v suspenzi (jako plaveniny) (Garde, Raju,
1977). Transportni funkce byla zaloZena na velikosti ¢astic, jejich mobilité¢ a transportu
(Brunner, 2010a).
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Vztahem, ktery vyvinuli Ackers-White, je mozné pocitat s velikosti sedimentll v rozmezi
0,04 mm az 7 mm (Brunner, 2010a).

Vztah byl aplikovan asi na 1000 experimentech, kdy hloubka vody byla vétsi nez 0,4 m.
Bylo stanoveno nékolik koeficientll (Cexp, A, Fgr). Funkce je vhodna pro riizné typy dnovych
utvart, jako je rovné dno, vrasky a duny (Brunner, 2010a).

Rovnice popisujici koncentraci sedimentti:

de (U\" (F,
Cse = Cexp * Ps * D_h ) (u_*) ) (7 - 1) (4.19)
Cse.. .koncentrace sedimentu
Cexp. . .experimentalni koeficient
Fgr... parametr mobility sedimentii

A.. kriticky parametr mobility sedimentil
d) Piistup - Yang

Yang predpokladal, Ze dominantnim faktorem popisujici pritok sedimentd je unéseci sila
(stream power; US = rychlost*sklon), ktera je produktem rychlosti a te¢ného napéti.
Vyjadieni se skladd ze dvou rovnic, kdy jedna je pro pisek a druhd pro $térk. Rozmezi
praméru zrn je mezi 0,062 — 7 mm (Brunner, 2010a).

Rovnice pro pisek de<2mm

log C,, = 5,435 — 0,286 - log - W'Vde —0.457 - log - = + (1,799 — 0,409 - log - W'vde -
0,314 log: wxw-log-(U-Sw—Ukr-Sw) (4.20)

Rovnice pro stérk de>2mm

log Cse = 6,681 — 0,633 - log - = — 4,816 - log - == + (2,784 ~ 0,305 log - == —
0,282-log- uxw-log-(U-Sw—Ukr-Sw) (4.21)

Yang své rovnice upravoval i pozdéji, kdyZ se vénoval transportu sedimentil na Zluté
fece.
Existuje fada dalSich rovnic a pfistupt, které se vénuji celkovému transportu sedimentt.

Autofi se snazi bud’ pfijit na n€jaky novy zpusob ¢i upravuji dosavadni rovnice.
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5. Matematické modely

K modelovani transportu sedimentd existuje nékolik modelt. VétSina jich obsahuje
nekolik transportnich rovnic od raznych autort S podminkami pouziti (rozmezi praméru zrna,
hloubka apod.), ke kterym by mélo byt ptihlizeno pii vytvateni modelu.

Yang (2002) popsal, Zze zakladni model, ktery se zabyva transportem sedimentd,
by mél mit nasledujici charakteristiky:

- obsahuje takova matematicka vyjadieni, ktera jsou odzkouSena

- model mize byt aplikovan na oteviené koryto s okrajovymi podminkami

- model mize byt aplikovan na fi¢ni a bystiinné proudéni

- model pocitd a simuluje zménu podminek (hydraulika, tvar koryta) v podélném

1 pficném profilu

- model simuluje a predikuje geometrii koryta (hloubka, Siika)

- model simuluje rovnovéhu a nerovnovéahu transportu sedimentt

- model miize zahrnout specifické podminky, jako je stabilita ¢i eroze

- model by nemé¢l poZadovat data, jeZ je t¢Zké ¢i nemozZné ziskat

Modely pocitajici transport sedimentii miizou byt 1D, 2D ¢i 3D. Nejcastéji se pouZivaji
1D modely, nebot’ vyzaduji nejméné dat, nepotiebuji velké mnozstvi pocitacové paméti
a feseni je relativné stabilni (Yang,2002).

Piiklady 1D modelt zabyvajici se transportem sedimenti: FLUVIAL , GSTARS, MIKE
11, HEC-RAS (dtive pro sedimenty HEC-6) a dalsi. Software je bud’ voln¢ dostupny napf.
HEC-RAS ¢i komer¢ni jako je napt. software od DHI.

5.1.Program HEC-RAS

Jednd se od 1D hydrodynamicky model, ktery slouzi k modelovani ustaleného
a neustaleného proudéni, transportu sedimentii a zmény teploty ve vodnim proudu. Software
je vyvijen U. S. Army Corps of Engineers River Analysis System a je voln¢ dostupny.
Jeho aktualni verzi (nyni HEC - RAS 4.1) s doprovodnou dokumentaci 1ze najit na internetu:

http://www.hec.usace.army.mil/software/hec-ras/

Hydrologic Engineering Center vytvari i dal$i programové vybaveni: Srazko-odtokovy
model (HEC-HMS), simulace systému nadrzi (HEC-ResSim), model povodiovych skod
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(HEC-FDA). Vystupy z HEC-RAS lze proto pouzit i v dalSich programech vyvojové dilny
HEC.
5.1.1. Analyza transportu sedimenti v programu HEC - RAS

Model pro transport sedimentl je navrzen tak, aby simuloval zménu geometrie koryta
(vymilani ¢i ukladani), urceni stability koryta, priitok splavenin apod.
K vytvofeni modelu a nasledné analyze transportu sedimentti v programu HEC- RAS,

jsou vyzadovany nasledujici soubory (obr. 12):

Eaeo ; 1 e - soubior kv o

T spulbor 5o ol 3
i HFC-RAS4.1.0 L [l =1 | (=]
File Edhit Hur Uptions UI:- lools Halp

e T
|=»|uq_e;1h41’ Tl D] 2] I(,Eja | O e e P 1o P P o ] ol EEE . 1
Frojmok: [STREAREN =] 15 O patre ni_ el D s 0 ] OO e T O, pr| L .I|
Flan: [BFAATD [ S patres il_Fuar il s s S s TR E P 10, pin
G mermmbrg [OFaATO |L\:\l.lpcltrum_hurm_l.lpclvcl\l.l L R e R NS R )]
Stmmcy Flows: |
. Ruasi Linstisan Iyll_ll"AVPﬂ 1] 6 A matmnl_ e paseabsio Fasda T 0 Paiia T o als
Urstmach Flov: | |
Smclirmming: [OP&METT B StpatiaEnl i il G pasea S Fdsdds T s 0 PSS T sna
Dimzeriptior @ | - |___J |I5| Lipits

Obrazek 12 - potirebné soubory k analyze transportu sedimenti v HEC-RAS
- soubor geometrie koryta (Geometry file; *.g0x) — zahrnuje schematizaci ficni sité,

pficné profily vcetné inundace a struktury na toku, které charakterizuji koryto.

Jedna se o zakladni prvek modelu.

- soubor quasi-neustaleného proudéni (Quasi-unsteady file, *.g0x) — jedna

se o specialni soubor, kter}'/ je vazan kvypoétu transportu sedimenti. V tomto
okrajové podminky. Jedna se o horni okrajovou podminku popsanou ¢asovou fadou
prutokd (Flow series) a dolni okrajovou podminku, ktera muze byt popséana
¢asovou tadou hloubek (Stage time series), konsumpéni kiivkou (Rating curve)
¢i normalni hloubkou ¢i sklonem hladiny (Normal depth). Vnitini okrajové
podminky nejsou nutné, ale mohou byt stanoveny pomoci bocni ¢asové tady
prutokt (Lateral flow series) ¢i rovnomérné boc¢ni Casové fady pratokt (Uniform

laterdl flow series).

Quasi-neustalené proudéni je zaloZzeno na aproximaci série ustaleného proudéni,
kdy délka ustaleného proudéni (flow duration) je rozdélena do nekolika vypocetnich krokd -

computation increment (obr. 12).

41



délkea trvani
Q istaleného proudéni

vypocetni krok

cas

Obrazek 13 - vypocetni schéma quasi-neustaleného proudéni (Brunner, 2010a)

Zavedeni vypocetnich krok je zalozeno na predpokladu, ze zména geometrie dna mezi
vypocty hydraulickych parametrii neni dostacujici. Proto podle velikosti proudéni se zvoli
vhodny pocet vypocetnich krokl, kdy dojde k pfepocitini geometrie dna. Pii nizkych
hodnotach pritoki neni potfebné mnoho vypocetnich krok, ale pti vysSich prutocich je lepsi
stanovit mens$i Casové kroky, kdy miize dochdzet k ¢astym zménam koryta. MenSi ¢asové

kroky vedou k vétsi stabilité modelu, i kdyz vypocetni ¢as bude delsi (Brunner, 2010b).

- soubor sedimentt (Sediment file, *.s0x) — v tomto souboru se stanovuji potiebné

hodnoty tykajici se sedimentl. Vkladaji se okrajové podminky mnoZstvi sedimentl
a parametry K urceni transportu sediment.

Parametry popisujici transport sedimentd (obr.14) jsou:

Tranzport Function: |Meyer Feter Muller j Disfine/Edit
Sorting Method: |E:-:ner 5 j Bed Gradation ...
Fall Velocity Method: |Van Riin |

Obrazek 14 - parametry popisujici transport sedimenti

Vypocetni funkce (transport function):

1. Ackers — White 2. Engelund — Hansen
3. Laursen (Copeland) 4. Mayer — Peter Miiller
5. Toffaleti 6. Yang

7.Wilcock

Vybér funkce je dilezity a na ném zavisi 1 vysledky modelu. Kazda ma okrajové
podminky (tab.6). Vétsinou jde o prumér zrna (d), hloubku (h), sklon dna (i), rychlost (v) atd.

(Brunner, 2010Db).
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d, d h i
Autor rovnice
[mm] [mm] [m/s] [m] [-]
Ackers-White | 0,04 7 NA NA ]0,021 | 2,164 | 0,003 | 0,427 0,00006 | 0,037
Englund-
NA NA 0,19 | 0,93 10,198 | 1,932 10,058 | 0,405 | 0,000055 | 0,019
Hansen
Laursen
NA NA 0,011 29 0,021 | 2,865 ] 0,009 | 16,459 ]0,0000021 | 0,0018
(Copeland)
Meyer-Peter-
. 0,4 29 NA NA 10,366 | 2,865 ] 0,009 | 1,189 0,0004 0,020
Miller
Tofaletti 0,062 4 0,095 | 0,91 {0,213 | 2,377 10,021 | 17,282 ] 0,000002 | 0,019
Yang 0,15 7 NA NA 10,244 | 1,951 ] 0,012 | 15,240 | 0,000043 | 0,029
Wilcock NA NA NA NA NA NA NA NA NA NA

Tabulka 6 - okrajové podminky funkci (Brunner, 2010b)

e Metody tridéni zrn (Sorting method):

K vybéru jsou dv€é moznosti a to tfivrstvy model dna EXNER 5, kde je feSeno

vymilani a ukladani v kryci vrstvé, druhou moznosti je dvouvrstvy model AKTIVNI

VRSTVY, kdy je pouziti omezeno pro Stérkové dno (Brunner, 2010b).

Vymildni a zanaSeni se realizuje fyzikdlné jinym zpisobem. ZandSeni zavisi

pfedevSim na usazovaci rychlosti zrn, kdeZto vymildni zavisi na vzdjemné interakci

usazenych zrn s proudem (Zachoval, 2009).

_podpovrchovi ';'fsh'a p

nealktvini
vrstva

Obrizek 15 - model t¥idéni zrn EXNER 5 a model AKTIVNI VRSTVY (Brunner, 2010a)
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e Sedimentaéni rychlost (fall velocity method):

K vybéru je nékolik metod, pro vypocet sedimentacni rychlosti. Prvni vztah tykajici
se sedimentacni rychlosti je RUBYho pfistup (1933), ktery je zalozen na kombinaci
Stokesovy rovnice (jemné materidly) a impaktni formule (velké castice mimo Stokese)
(popsano v kapitole 2.7).

Druhym vztahem je TOFFALETIho pfistup (1968), ktery vytvofil tabulku rychlosti
zavislych na teploté a velikosti ¢astice, kdy tvarovy soucinitel zrna je 0,9 a mérna tiha ¢astice
(v) rovnajici se 2,65 N'm™,

Tfetim vztahem je pifistup VAN RIJNa (1993), ktery aproximoval kiivky
pro sedimentacni rychlosti pro Castice, které maji tvarovy soucinitel 0,7 a stanovil tfi rovnice,
které jsou zavislé na praméru zrna (d).

Posledni moznosti je REPORT 12, ktery je podobny pfistupu Van Rijna. Pouziva
sedimenta¢ni rychlost k vypoétu nového Re ¢Cisla a nasledné znovu pocita sedimentaéni
rychlost, dokud nebude rychlost v dané toleranci (Brunner, 2010a).

e Zrnitostni sloZeni a limity eroze a vymilani:

Kazdy pfi¢ny profil musi byt spojen se vzorkem zrnitostniho sloZeni dnovych
splavenin. Jeden vzorek zrnitostniho slozeni mtze byt spojen s nékolika pti¢nymi profily
nebo mohou byt vzorky interpolovany mezi pfi¢nymi profily.

Vzorky zrnitostniho slozeni (Define/edit bed Gradation...) se vytvareji, vloZzenim
procentudlniho zastoupeni pfislusSné zrnitostni tfidy. V HEC-RAS je definovéano
20 zrnitostnich tfid, které si mize uzivatel podle potfeb zménit (Brunner, 2010b).

U kazdého pficného profilu je nutné nastavit bocni limity pro erozi a vymildni,
maximalni hloubku ¢i minimélni nadmoiskou vysku. Jednd se o limity, kam aZz mizZe

dochazet k erozi ¢i ukladani (Brunner, 2010b).
Okrajové podminky:

UrCuji mnozstvi piitoku sedimenti do systému. Horni okrajovd podminka

vvvvvv

byt stanoveny piidanim profilti pomoci tlac¢itka Add boundary location (Brunner, 2010b).
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Stanoveni okrajovych podminek muze byt uréeno nasledovné:

Equilibrium load — program pocita pro kazdy casovy krok kapacitu transportu sediment,
jako pritok splavenin. V daném profilu nedochazi k vymilani ¢i usazovani. Tato podminka
muZze byt stanovena pouze na horni okrajové podmince.

Rating curve — urceni pfitoku splavenin na zaklad¢ ptitoku tekutiny.

Sediment load series — zahrnuje v sobé Rating curve a ¢asovou sérii ptitoku sedimenti
(Brunner, 2010b).

- soubor k vypoétu (plan file, *.p0x) - v tomto souboru se stanovuji rizné podminky

a tolerance, jak bude probihat vypocet a jak by mély vypadat vystupy.
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5.2. Priprava dat a vizualizace vysledki

Ptiprava dat ¢i vizualizace vysledkli nemusi probihat pouze v ramci programu HEC-RAS.
Do programu Ize importovat data zprogrami GIS ¢ CAD. Jedna se vétSinou
0 3D schematizaci. HEC-RAS pouziva k vypoctim pouze 2D data, informace nesouci teti
rozmér jsou pouzité az k zobrazeni vysledkt. Vysledky vypoctl 1ze exportovat zpét do GIS ¢i
CAD a dale zobrazit napt. zaplavové oblasti, rozdéleni rychlosti a te¢né napéti.

Jednd se o extenze do programu, které si lze stdhnout a po instalaci je pouzivat.
Existuje fada voln¢ dostupnych programt podporujici GIS/CAD (napf. GIS GRASS...).
Vyvinuté extenze jsou, ale podporovany komerénimi programy. Jedna se ArcGIS od firmy
ESRI a programy od firmy AutoDesk.

5.2.1. CAD

Produkty firmy AutoDesk podporujici import a export dat zZdo HEC-RAS jsou AutoCAD
Civil 3D a AutoCAD Map 3D. Tyto programy Vv sobé zahrnuji import/export nebo si uzivatel
mize stahnout extenzi, ve které mize provadét dalsi upravy, analyzy a vizualizace dat.

K praci v AutoCAD Civil 3D/ AutoCAD Map 3D lze pouzit tyto nastroje:

Import a export HEC-RAS — soucasti programu od verze Civil 3D 2011 (obr.16)
T R - . - . v

e Modify Analyze View [EeNGINE Manage Help Online | Add-lns = Express Tools o -

@ @ Ea Page Setup Manager @ s’ <05 {0; Export Points Ep Export Civil Objects to SDF

View Details D[S Transfer Points @ Export to Storm Sewers

Plot Batch Preview Publishto Share with | Exportto
Plot g Plotter Manager GoogleEarth  Seek | LandXML |[E] Export to HEC RAS| 8 Export to Civil View for 3ds Max Design
Plot ¥ Publish [ Export |

Obrazek 16 - export vytvoieného souboru z AutoCADu Civil 3D do HEC - RAS

Navod jak lze pracovat v AutoCADu Civil 3D 2011, popsal Andy Carter (2011)
z Texaského institutu Halff Asociates z oddéleni Texas Water Resources Department. Pracuje
v programu AutoCAD Civil 3D 2011 a jako terénni podklad pouziva soubor LIDAR (jedna
se 0 snimani terénu, které je zobrazeno mra¢nem bodu; soubor ma koncovku *.1as).

Manual 1 spodrobnymi video ukazkami a zkuSebnimi daty jsou dostupné

na:  http://au.autodesk.com/?nd=event_class&jid=1727888&session_id=9109.  Popisuje,

jak lze vytvorit koryto, pficné profily, exportovat do HEC — RAS, praci v RAS Mapperu
(GIS nastroj v programu HEC — RAS) a zobrazeni zaplavové oblasti opét v AutoCADu Civil

3D 2011.
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River Analysis — tato extenze neni automaticky soucasti a pokud by ji chtél uzivatel

pouzit, musi si ji stahnout (http://labs.autodesk.com/utilities/civil3d_river). Diive tato extenze

nesla jméno RiverCAD a byla vyvijena firmou BOSS INT. K piejmenovani doslo po

odkoupeni prav. Jedna se o pokroc¢ilou podporu pro fi¢ni modelovani v HEC —RAS (obr.17).

Obrazek 17 - River Analysis a ukazka dat z AutoCAD Civil 3D 2012

Autofi této extenze uvadi nasledujici funkce:

- tvorba pricnych profild, provadéni analyzy, zobrazovani zaplavové oblasti atd.

- HEC-RAS miize pocitat nékteré vypocty v bezproblémove v ramci vykresu AC3D/
AM3D

- podpora rtiznych formatd modelt terénu (3D digitdlni vrstevnice, TIN, DTM,
DEM, LIiDAR, data z terénu, ...) pro ziskani pfi¢nych profila apod.

- import dat z HEC-RAS

- vytvofeni staniCeni biehd, zahrne riznd mista (inefective areas, obstructions,
leeves,...),

- z topografickych map lze ziskat Manningliv soucinitel drstnosti

- Ize provadét analyzu mostd a propustki
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- vytvaii povodiiové mapy (v Americe je lze exportovat do predpovédni sluzby

povodni FEMA)

- podporuje US 1 metrické (SI) jednotky

- prosttedi by meélo byt wuzivatelsky ptrivétivé a jednoduché k nauceni

bez ptedchozich zkuSenosti s programy AutoCAD. (AutoDesk 2011)

Extenze je stale ve vyvoji a do verzi programti 2012 si lze stdhnout pouze do ¢ervna 2013.
Piedpoklada se, ze bude nadale vyvijena tak, aby byla stalou soucasti programu
od verze 2014.

V ramci diplomové prace jsem River Analysis vyzkousela v prostiedi AutoCad Civil 3D
2012. Nahrala jsem vrstevnice (Insert->Survey data->Make Survey from GIS data) a terénni
data (River->Import->HEC-RAS data) zprogramu HEC -RAS (viz  Obrazek 18).

Zobrazovani vysledki a analyzy v programu nebyly provadény.

D e e LIRS S S W
Obrazek 18 - ukazka nahrani nékterych poskytnutych dat pies River Analysis do AutoCAD Civil 3D

5.2.2. GIS

Pro prostiedi programu ArcGIS for Desktop 10.1 je samotnym U.S. Army uz déle
vytvarena extenze HEC—geoRAS. Tato extenze je dostupna ke stazeni na strankach U.S.
Army Extenzi lze stahnout i pro nejnovejsi ArcGIS 10.1.

V ramci piipravy dat v ArcMapu s HEC-GeoRAS mizeme ziskat geometrii koryta
(podélny profil, pticné profily, bfehy, proudnici atd.) a parametry modelu (drsnostni
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soucinitele). Vysledky z modelu mohou byt zpét importovany, kde lze provadét dalsi analyzy
(zaplavova uzemi, rozloZeni rychlosti).

V ramci diplomové prace jsou poskytnuta data zpracovana v ArcMapu za podpory
HEC-GeoRAS. Jak se extenzi pracuje je popsano V nasledujicich kapitolach (viz. kap. 6.2.2
a 7.2) a prilohach 3 a 6.
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6. Metodika

Tato c¢ast diplomové prace je zaméciena na sestaveni modelu a moznosti extenze
HEC- geoRAS pii vytvareni modelu a nasledné vizualizaci vysledka (pre- a post- procesing).
Popisu vlastniho sestaveni modelu ptredchdzi popis zajmového uzemi feky Opavy

a potfebnych dat pro sestaveni modelu v useku . km 93,461 - . km 84,506.

6.1.Popis zajmového uzemi

6.1.1. Informace o toku

Reka Opava vznika soutokem tif tokt (Cernd, Stfedni a Bild Opava) pramenicich
na svazich Hrubého Jeseniku. Stékajicich se u Vrbna pod Pradédem. Reka usti do feky Odry
u Ostravy (obr. 19). Délka toku je 109,3 km s plochou povodi 2088,8 km® a primérmym
ro¢nim pratokem 15,01 m®s™? (Povodi Odry, 2012b). Reka spada do povodi Odry.

Horni ¢ast toku po Vrbno pod Pradédem protéka zalesnénym uzemim. Dale feka prochazi
malymi a vétSimi sidly. V extravildnu je krajina kolem feky vétSinou zemédélsky vyuZzivana.
Nejvyznamnéjsi sidla na toku jsou Krnov, Opava a okrajové Ostrava (Povodi Odry, 2012b).

Pritoky na fece nejsou vyznamné ovliviiovany uzivanim vody (odbéry ¢i vypousténim
odpadnich vod). Mezi hlavni piitoky Opavy patii Opavice, Cizina a Moravice. (Povodi Odry,
2012Db).

Cela feka Opava patii do spravy Povodi Odry s.p., kromé horni &asti Cerné Opavy,
kterou spravuji Lesy Ceské Republiky s.p.

Obrazek 19 - Feka Opava — v celém rozsahu (Kubacka J., Kubacka M., 2009)
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Vybrany tsek toku pro model se nachazi v horni ¢asti feky Opavy 93,461 - 84,506
. km (obr. 15). Povodi Opavy je rozdéleno do 6 -ti vodnich utvard. Podle privodniho listu
od Povodi Odry (Povodi Odry, 2007a) spada do ¢asti: Opava po soutok s tokem Opavice.

Soutok Opavy

| AE‘
> ,"’ ‘ 1:50 000

KELAROVA. Zuzans
miz

1
soufadnicovy system: S JTSK

C ;zmcg IMS sh2ba nip /lgeapontalgov c

|
|
|

a Opavice je v Krnové.

Obrazek 20 - zajmova ¢ast uzemi v SirS§im vztahu okoli (zdroj:autor na podkladech Geoportalu, 2010)

Zékladni charakteristiky toku podle privodniho listu Povodi Odry (Povodi Odry, 2007a):
Pracovni ¢&islo VU: 25/CZ

Cislo hydrologického povodi: 2-02-01-038

Nadmoftska vyska: 200 — 500 m.n.m

Plocha dilgiho povodi: 370,82 km?

Staniceni toku: 69,0 — 95,0 f.km

6.1.2. Klimatické poméry

Dle Quitta (1971) lezi zdjmova oblast na rozhrani dvou klimatickych oblasti MT2 (mirné
tepléa oblast) a CH7 (chladna oblast).

Pro ob¢ oblasti je typické kratké, mirn€é chladné a mirné vlhké 1éto. Zima je delsi s mensi
sn¢hovou  pokryvkou. Ptechodna obdobi v oblasti CH7  jsou  dlouhd
a chladna a v MT2 s mirnym jarem i podzimem (Quitt, 1971). Dalsi charakteristiky danych
oblasti jsou popsany v Tabulka 7a mapa oblasti je uvedena v piiloze 1.
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PARAMETRY MT 2 CH7
Pocet letnich dnti 20-30 10-30
Pocet dnii s primérnou 140 - 160 120 - 140
teplotou 10°C a vice
Pocet mrazovych dnil 110 - 130 140 - 160
Pocet ledovych dna 40 - 50 50 - 60
Primérna teplota v lednu -3°C - -4°C -3°C - -4°C
Primérna teplota v 6°C - 7°C 4°C - 6°C
dubnu
Primérna teplota v 16°C - 17°C 15°C - 16°C
cervenci
Primérnd teplota v fijnu 6°C - 7°C 6°C - 7°C
Primérny pocet dnti se 120 - 130 120 - 130
srazkami 1 mm a vice
Srazkovy thrn ve 450 - 500 mm 500 - 600 mm
vegetacnim obdobi
Srazkovy tthrn v zimnim 250 - 300 mm 350 - 400 mm
obdobi
Pocet dnti se snéhovou 80 - 100 100 - 120
pokryvkou
Pocet dnli zamracenych 150 - 160 150 - 160
Pocet dnii jasnych 40 - 50 40 - 50

Tabulka 7 - charakteristika klimatickych oblasti (Quitt, 1971)

6.1.3. Geomorfologie, Geologie, Hydrogeologie a piidni poméry

a) Geomorfologie

Systém: Hercynsky

Provincie: Ceska vyso¢ina

Subprovincie: Krkono§sko — jesenicka soustava
Oblast: Jesenicka

Celek: Nizky Jesenik

Podcelek: Branticka vrchovina; Bruntalska vrchovina

Okres: Krasovka vrchovina; Razovska vrchovina a Svétlohorska vrchovina
(Geoportal, 2010)
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b) Geologie a hydrogeologie

Z pohledu geologie se uzemi nachazi v Ceském masivu v Moravskoslezské oblasti
a v jednotce Moravsko-slezsky spodni karbon (kulm). Nachazeji se zde paleozoické horniny
zvrasnéné metamorfované (bridlice, droby, kvarcity, vapence) a kvartér (hliny, sprasové
hliny, pisky a Stérky) (Geoportal, 2010). V oblasti by mély hlavné ptevazovat erné jilové
btidlice (Landa, 2007). Mapa geologického uzemi je uvedena v piiloze ¢. 1.

Hydrogeologicky je oblast deficitni. Propustnost je pralinové - puklinova. Hladina
podzemni vody je ¢asto hlubsi nez 30 m (Landa, 2007).

Z hlediska hydrogeologickych rajont spadd do rajonu Kulm Nizkého Jeseniku (6611).
Oblast kolem Krnova spada do rajonu Kvartér Opavy (1520) (HEIS VUV, 2002).

c) Pudni poméry

V oblasti jsou zastoupeny z puidnich druhti hliny piséitohlinité a hlinité. Z padnich typa
to jsou kambizemé, fluvizemé, organozemé a gleje (Geoportal, 2010). Mapa je uvedena

v priloze ¢.1.
6.1.4. Hydrologické poméry

Na Krnovsku dosahuje primérny thrn srazek 550-700 mm, sklon dna feky Opavy
je vdaném useku 5 %o a pramémy specificky pritok se pohybuje mezi 5 - 10 I's“km™
(Povodi Odry s. p., 2007b).

N-leté prutoky a M-denni prutoky jsou uvedeny v nasledujici Tabulka 8:

Tabulka 8 — M —denni a N-leté priitoky (povodi Odry s.p. 20073a)

. N-eté pritoky Q, Q; Qs Q1o Qx Qsp Q100
Hydrologické |5 2 249 | 411 | 69.8 | 97.0 129 180 225
charakteristiky livnéné Nleté
uzavérného profilu [ oS =
M-denni prutoky | Qspq Qoos | Qusos | Qzr0a Q3304 Qassy Qigeq
Q,m¥ | 433 |mis 969 | 535 | 308 | 183 112 0.738 0.467
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6.2. Sestaveni modelu

6.2.1. DATA

Data potiebna pro sestaveni modelu v HEC — RAS byla poskytnuta statnim podnikem
Povodi Odry:

- pricné profily koryta feky od stani¢eni 93,461 -70,120 .km

- zaméiené body koryta

- soucinitel drsnosti (u pfi¢nych fezl)

- pratoky umélé ro¢ni povodinové viny

- zrnitostni sloZeni dna feky Opavy (5 vzorkt, pouzity 3)

Pro pre- a post- procesing v programu ArcGIS sextenzi HEC-GeoRAS a hlavné
k vytvoteni vhodného digitalniho modelu terénu (DTM, format TIN) byla ziskana data
vrstevnic a grid 10x10 m od CUZK. Jedna se klady listéi 15-31-03 a 15-31-04.

Dal$i pomocna data byla stazena z dostupnych webovych stranek. Pro model byly pouzity

*shp vrstvy vytvofené v ramci projektu DIBAVOD (http://www.dibavod.cz/).

6.2.2. Prace v programu ArcGIS

Pfed samotnym vytvafenim vstupnich dat do programu HEC-RAS v extenzi
HEC-GeoRAS je zapotiebi vytvorit digitalni model terénu (DTM ve formatu TIN). Ten
je nutny proto, aby mohly byt odecteny nadmoiské vySky napt. pti vytvaieni pticnych profild.
Je tedy potiebné, aby byl model terénu v okoli feky byl co nejpiesnéjsi v okoli feky.

Digitalni model terénu (DTM ve formatu TIN) zdjmového tizemi byl vytvofen z vrstev
vrstevnic, gridu 10x10 a zaméfenych bodi koryta. Mapka vytvoreného modelu terénu
je vpriloze 2.HEC-GeoRAS podporuje dva formaty digitadlniho modelu terénu GRID
nebo TIN.

Po vytvofeni TINu lze pfistoupit K vytvoreni dat pomoci HEC-GeoRAS, které
se budou exportovat z ArcGIS do HEC-RAS. Pro potieby HEC-RAS musi byt minimalné
vytvofena vrstva stfedové linie toku a pficné fezy. Pro dalsi analyzy je vhodné pfidat i dalsi

vrstvy (napf. biehové linie).
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Lista HEC—GeoRAS (obr.16) obsahuje nastroje pro ptipravu dat (RAS Geometry), nastroje
pro analyzu dat (RAS Mapping) a pro Gpravu formatu dat (ApUTtilities).

RAS Geometry = RAS Mapping ~ 5¢ &8 || & = < &F apUtilties = Help -
Obrazek 21 - lista HEC - GeoRAS v ArcGIS (zdroj: autor)

V zalozce RAS Geometry ->Create RAS Layers byly vytvoteny vrstvy: stiedové linie
toku (Stream Centerline), biehy toku (Bank Lines), proudnice (Flow Path Centerlines)
a pricné profily (XS Cut Lines). Jednd se o nejdulezitéjsi vrstvy, které by mély
byt vytvoreny. V piiloze €. 3 je detailn€jsi popis, jak se tyto vrstvy vytvareji.

VSse se ukladd do databaze(OPAVA.mdb), kterd ma stejné jméno jako mapovy dokument
(Opava.mxd). Vrstvy databaze lze vytvofit najednou a postupné je vyplilovat potfebnymi
daty anebo postupné pridavat. V ramci piipravy dat nebyly vlozeny vSechny vrstvy.. Pocet
vrstev zavisi na dostupnych podkladech. Pokud by byla dostupna vrstva Landuse,
tak l1ze pomoci ni Ize vygenerovat Manninglv soucinitel drstnosti (n). Diky leteckému snimku
¢i ortofotomapy lze stanovit rizna uzemi: napt. inefective areas - program pocita,
ze je v téchto mistech proudéni nulové dokud se tam nedostane voda (nasledné uz je tato ¢ast
profilu zahrnuta do vypoctu), obstructions - uzemi, které voda obtéka ¢i hraze (leeves)
a dalsi.

Jakmile jsou vytvofena potfebna data (linie feky, brehy, flowpaths a pfi¢né profily)
Ize je vyexportovat do souboru OPAVA.RASimport.sdf. Tento ptipraveny soubor je jiz mozné
importovat do HEC-RASu.

6.2.3. MODEL

Do programu HEC-RAS se po stupné¢ vkladaji potiebné soubory pro danou analyzu.
Soubory nutné pro analyzu transportu sedimentii jsou popsany v kapitole 5.1.1. VSechny c¢asti
jsou soucasti projektu (OPAVAL0.prj).

Jelikoz se jedna o americky program jako vychozi nastaveni jednotkového systému
je US Customary. Zménu jednotkového systému lze provést v zalozce Options-> Unit
systems na SI jednotkovy systém. Dal$im upozornénim pro praci s programem HEC-RAS
je, ze desetinna mista oddé€luji teCkou a ne ¢arkou. Zmeéna tohoto parametru se miize provést

V mistnim nastaveni pocitace.
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Vkladani dat

K vytvoreni analyzy sedimenti musi byt nejdiive vyplnény vSechny potiebné soubory,
ze kterych pak program pouziva data.
se mohou vkladat ru¢né ¢i importovat z formati GIS ¢i CAD. Pti vytvafeni projektu byla
k importu pouzita data vytvoiena pomoci extenze HEC-GeoRAS. Pfed importem dat je nutno
novy Geometry file ulozit (OPAVA10.g01). Import dat se provede nasledovné: File ->
import Geometry data -> GIS format. Po té je poticba nalézt importovany soubor
(OPAVA.RASIimport.sdf ) a nastavit pozadované parametry v nabizenych podkonech.
Vysledek vkladani konkrétnich dat je patrny z Obrazek 22. Importované pii¢né profily byly
dale jeste ruéné doopraveny podle poskytnutych pricnych fezl a zaroven byl zadan soucinitel
drsnosti.
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Obrazek 22 - Geometrie Feky (zdroj:autor)
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Dalsim krokem po ukonceni editaci v geometrickém souboru je na tad¢ vlozeni dat
do souboru QUASI — UNSTEADY FILE. Je nutné stanovit horni i dolni okrajovou podminku
proudéni. Horni okrajova podminka je popsana ¢asovou fadou prutoku (flow series). Byla
vloZzena uméle vytvofend rocni povodiiova vina s piibliznym kulminacnim pritokem
Qso (Obrazek 23) po dobu 15-ti let. Na obrazku je zobrazeno délka trvani daného pritoku.
Dolni okrajova podminka je popsana pomoci sklonu dna (Normal Depth) s hodnotou i=

0,00463.
Flow Computation
Diuration Increment Flow
[hours] [hours] [m3/z)

24 24 318
BE0 EEO 0.815
720 720 1.61
720 720 268
720 720 498
180 180 11.042

18 18 26.66
1.8 18 E3.641
0.36 0.36 153.368
0.43 0.43 117,691
0.96 0.96 82,933
4.8 48 48.836
96 36 34414

48 48 20122

96 96 14.093
240 240 8.427
480 480 7.05
720 720 3.91
720 720 32
720 720 228
720 720 1.91
720 720 1.34
720 720 1.08
408 408 0.537
132 132 0.335

Obriazek 23-Uméla povodiiova vina (zdroj:povodi Odry s.p.)

Jelikoz dochazi k ovliviiovani prutoku Opavy i pritoky malych toku, byly vlozeny
podobné povodiové viny (Lateral flow series) ke ¢tyfem pii¢nym profilim.

Posledni a dilezity soubor je Sedimet file. Ke kazdému pii¢énému profilu je nutné piiradit
zrnitostni slozeni. Tato zrnitostni charakterizace toku se provede tak, Ze se pouziji tdaje
o zrnitostnim slozeni nékolika vzorkii dnovych sedimentl a zbytek se interpoluje. Na vybrané
¢asti feky byly pouzity udaje 3. vzorkd, které dostateCné vystihovaly charakter zkoumané
¢asti toku. Na fece Opavé prevladaji Stérky s ptimeési pisku. V malém mnozstvi se vyskytuje
jil a prach. A jejich sloZeni se rychle neméni.

Pti vkladani zrnitostniho slozeni vzorkii do souboru bylo vytvofeno vlastni zrnitostni
rozdéleni S procentickym zastoupenim jednotlivych slozek (viz. ptfiloha 4). Dale nasleduje
pfifazeni vytvofenych zrnitostnich vzorki k pfi€énym profilim. U zbyvajicich vzorki byly
data ziskany interpolaci, jak je zminéno Vv kapitole 5.1. Tento krok se provede tlacitkem
Interpolate gradation.
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vvvvv

Nejvice se svymi okrajovymi podminkami (viz. Chyba! Nenalezen zdroj odkazi.) na
daném uzemi blizi vypocetni funkce Mayer — Peter Miiller, ktera patii mezi nejcastéji
pouzivané. Zbylé funkce (Englund —Hansen, Toffaletti, Ackers —White, Yang) byly vytazeny,
jelikoz pocitaji s malym zrnitostnim sloZzenim. Funkce (Laursen) byla vyfazena pro nizky
sklon dna a funkce (Wilcock) pro nedostatek informaci o podminkach.

Po vyplnéni vSech pottebnych parametri pro vypocet modelu je nutné spustit analyzu

pomoci - Sediment transport analysis (plan file (obr. 24).

;,-'E-,‘,SEdimentTransportAnaI].rsis EI = @
File Options Help

Flan: JOP&VATO Shaort [ |OP10

Gearnetry File : | OP&yVAT0 ﬂ
Quasi-Unsteady Flow : | DP&YA1D |
Sediment Diata : |DP&AA10 |

Sirnulation Time YWindaw

Starting D1 ate: |3'| dec1939 J Starting Tirme: | 2400
Ending D ate: |3'| dec2015 J Ending Time; | 2400

Plan Description

Compute |

Enter/Edit shart identifier for plan [used in plan comparnzons)

Obrazek 24 - Plan file (zdroj:autor)

Pfed samotnym spusténim vypoctu je nutné nastavit asové rozmezi vypoctu. Zadava
se ve formatu DEN:MESIC:ROK a ¢as ve 24 hodinovém formatu (Obrazek 24). V zalozce
Options lze zménit vychozi koeficienty.

Ve vyse uvedeném piikladu byl modelovan vyvoj koryta béhem 15-ti let se stale stejnou
povodinovou vinou. Pro zjisténi, zda se stav koryta méni se jedna o dostatecné dlouhy casovy

usek. Delsi ¢asovy usek byl zvolen proto, aby $lo posoudit vyvoj koryta.
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7. Vysledky

Jakmile je vypocet proveden lze vypocitané parametry modelu zobrazit v riznych grafech
a tabulkach, které na vysledky pohliZzeni z riznych uhla napt. jak se koryto méni jako podélny
profil ¢i jako samostatné piicné profily. Dale lze také zobrazit stejné vysledky jako
u ustaleného proudéni (Steady flow) napt. rozliv vody, konzumpéni kiivku atd. Do programu

ArcGIS je také mozné exportovat zaplavova tizemi.

7.1.HEC - RAS

Nejdilezitéjsim vysledkem je zména koryta béhem doby modelovani a K jakym zménam
dochazi (vymildni ¢&i wusazovani sedimentd). Dochézi k ovliviiovani toku neustale

¢1 jen pfi vétSich pratocich?

Vysledky k transportu sedimenti se mohou zobrazit tfemi zptisoby:

- View ->Sediment spatial plot. Jedna se o podélny profil. Jako zakladni profil
je nastaven pocate¢ni (ptivodni) profil. K porovnani se musi v zalozce Profiles
zaskrtnout dals$i podélné profily k porovnani. U sestaveného modelu bylo zvoleno
porovnani po 5, 10 a 15 letech (Obrazek 25). Vysledky lze zobrazit v grafické
form¢ jako podélny profil (profile plot) ¢i barevné odliSeny obrazek hloubek

(schematic plot) ¢i v tabulkové formé (Table).
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- View ->Sediment time series plot. Zde Ize zobrazit v grafické ¢i tabulkové formé

zménu nadmoiské vySky dna v pribéhu celého mode modelovaciho ¢asu (15 let)

kazdého pii¢ného profilu (Obrazek 26).
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Obrazek 26 - zména dna v ¢ase (zdroj: autor)
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- View ->Sediment — XS Bed Change Plot. Jedna se o vykresleni celych pfi¢nych
fezl a stejné jako u Sediment spatial plot je mozné zvolit n¢kolik pticnych profild

v Case k porovnani (Obrazek 27). Vypsat lze i tabulkové porovnani.

Ew
§
e

e \ / Obrazek 27 - zména p¥Fi¢ného profilu
| (zdroj:autor)

Ze vsech tii zobrazeni (obr. 25-27) je zcela patrné, Ze dno je stabilni a méni se velmi
pomalu. Nejveétsim zménam dochazi béhem vyssich pritokd (Qz a vyse). I kdyz pienosu
sedimentd dochazi, neovliviiuje to nijak rozliv vody mimo koryto.

Pravé dalsi vysledky mohou ukézat, jestli je ovlivnéno zaplavové izemi béhem transportu
sedimentl. Jedna se o zobrazeni stejnych vystupii, jako napt. u modelu ustadleného proudéni.
Jedna se o vyobrazeni rozlivu vody mimo koryto v celé jeho délce ¢i opét jen v pfiénych
profilech Také je zde mozné zjistit naptiklad rychlostni sloZeni v profilu (Obrazek 28) a dalsi
zajimavé dopliujici informace. Pravé tyto vysledky lze zobrazit napi. v RAS Mapperu, GIS

¢1 CADu a porovnat.

Obriazek 28 - rychlostni rozloZeni (zdroj: autor)
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Zobrazeni zaplavovych tizemi v RASMapperu vyzaduje digitalni model terénu ve formatu
flt. Dfive vytvofeny TIN lze na tento format lehce prevést pomoci dvou nastroji
v ArcToolBox. Prvnim krokem je vytvofeni rastru (3D Analyst->From TIN-> TIN to Raster)
a druhym je pfevedeni na float to raster, coz je pozadovany .flt format (Conversion tools->
To Raster -> Float To Raster).

Zobrazeni zaplavovych mist a dal$§ich proménnych se v RASMapperu (GIS Tools
->RAS Mapper, v zakladni nabidce) provede zvolenim Tool->Floodplain mapping (Obrazek
29). V zobrazovaném okné, je nutné nahrat model terénu ve formatu *.flt. Nasledn¢ je potieba
vybrat zobrazeni profilti a proménnych veli¢in.

Zaplavové izemi je jako jediné ulozené ve formatu *.shp. Zbytek vysledkl je ulozen
ve formatu * flt.

Vysledky zéplavového uzemi a rozloZeni rychlosti jsou uvedeny v pfiloze €. 5.

o Flodpan Mspng ===
HECRAS Plan  OFAVAY v eyl DPRAID_1_ Vot 0!
HEL FAS Geowaty Tepolster Sufece
Foows Ly Deanety OF AVA YD Fres

X5 Laper Geceety OF AVAYXULOS

54 Lapwr

A4 le 0l

7 Use Sxis3ng Tiaetidee Ures | Gammetsy OPAVAI OGN Traration Lams

Corase irtecpolaton Seriece

sevaraie Ly Thone

Obrazek 29 - Floodplain Mapping (zdroj:autor)
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7.2.Vizualizace vysledki v programu ArcGIS

Dalsi moznosti, jak Ize zobrazit zdplavové tzemi a jiné proménné je export vysledki
do programu ArcGIS. Prvni krokem je export vysledkt z programu HEC-RAS (File
-> Export GIS) s koncovkou RASexport.sdf. Stejné jako v RASMapperu je vyzadovano
vybrani profilt, které budou exportovany. Dale je mozné zaskrtnout mnoho dopliujicich
hodnot k exportu.

Ve spuSténém a ulozeném programu ArcMap je nejdilezitéjsi prevedeni
exportovaného souboru na *.xIm format. Z tohoto formatu uz lze nacist vyexportované
hodnoty z HEC-RASu.

Nasledné uz lze vytvaret zaplavova tzemi (RAS Mapping->Inundation Mapping),
zobrazit rozlozeni rychlosti a dalsi. Podkladem nemusi byt jenom digitdlni model terénu,

jak je tomu RASMapperu, ale 1ze pouzit napiiklad ortofotomapy ¢i jiné mapové podklady.

Rozliv vody pii modelovini transportu sedimentu - nejvyssi pratok N

1:27 000

Obrizek 30 - zobrazni rozlivu pfi nejvyssim pritoku béhem modelovani transportu
sedimentu (zdroj:autor)
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8. DISKUZE

Prace meéla teoreticky cil a dva cile praktické. Teoretickym cilem bylo sezndmeni
se s problematikou pohybu sedimentt v tocich, ktera je zna¢né rozsahla. Praktické cile byly
pouziti prostiedku GIS (ArcGIS) a vyzkouseni schopnosti podpory programu HEC-RAS
a sestaveni obecného modelu transport sedimenti v HEC-RAS na fece Opave.

Pro lepsi znalost a piijemnéjsi uzivatelské prostiedi ke komunikaci s prosttedkem HEC-
RAS byl vybran program ArcGIS s extenzi HEC-GeoRAS. Volba programu muze zaviset
pouze na subjektivnim pocitu. Piiprava dat v ArcGIS probéhla velmi dobie. Ptesnost
vytvotenych pfi¢nych profilt zavisi na datech. I pfesto je dobré mit néjaké piicné profily
Kk porovnani a pfipadnému upraveni v HEC —RAS. Pro vytvofeni piesného digitalniho modelu
terénu jsou duilezité zamétené body v koryté a v okoli.

Do programu HEC-RAS byly nasledné vloZeny informace o proudéni vody a zrnitostni
slozeni dna ke kazdému profilu. Jelikoz proudéni vody vyzaduje Casovou fadu pritok,
je vhodné vlozit povodiiovou vinu, kterd bude mit v sobé zahrnut vyssi kulminaéni pratok
(napf. Qigo). Po vyplnéni vSech potfebnych dat byl vypocitan model na obdobi
15-ti let k posouzeni zmény koryta.

Doba 15-ti let byla vybrana jako dostate¢né dlouha doba, kdy by uz mohlo dojit aspon
k malym zménam koryta. Pti del§ich ¢asovych intervalech se samoziejmé prodluzuje i ¢asovy
vypocet modelu. Model 15-ti let byl modelovan okolo jedné hodiny. Na Obrazek 25 zasadni
zmény vidét nejsou, ale po zvétSeni grafu ¢i zobrazeni specifického piicného profilu
uz zmény lze pozorovat. Ani po patnacti letech nejsou zmény zasadniho charakteru,
coZ svédci o stabilnim dné. Je to hlavné diky velkému zastoupeni hrubSich (Stérkovych)
castic.

Predpokladam, Ze u tokli pfi vétSim zastoupeni pisCitych aZz prachovitych Ccastic
by dno a biehy byly vymilany vice. Tim by se mohlo zménit napf. zaplavové tzemi.
V mistech vymilani by se zmenSilo a v mistech usazovani zvétsilo. Zménami zaplavového
uzemi (pfi jemnéj$im zrnitostnim slozeni dna) a jeho zobrazovani v GIS programech
se ve svych pracich zabyvali Mervade et al. (2008) a Sinnakaudan et al. (2003).

Pravé zmény v zdplavovych tGzemich a hlavné samotnd Uzemi se nejlépe zobrazuji
v n¢jakém jiném prosttedku (napt. GIS ¢i CAD). Samotny HEC — RAS mé v sobé

implementovany svij nastroj GIS tzv. RASMapper. Lze v ném zobrazovat stejné vysledky,
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jako pti exportu do ArcGISu. V ArcGISu lze s vytvofenymi vrstvami provadét dalsi analyzy.
Vysledky nemusi byt zobrazeny jen na digitalnim modelu terdnu, jak je tomu u RASMapperu,

ale i na dalsich podkladech (napf. ortofotomapy ...).

9. ZAVER

Prace méla za ukol ovérit a vyzkouset, jaké jsou moznosti ptipravy a nasledné vizualizace
dat v GIS ¢i CAD prostfedcich ptfi matematickém modelovani v programu HEC- RAS.
Dalsim tkolem bylo vytvofit obecnou metodiku pro modelovani transportu sedimentl
Vv otevienych korytech.

Podpora programovych GIS ¢i CAD ma velky vyznam. Jak je v praci ukazano. V ramci
programu ArcGIS lze vytvaret geometricka data a dal$i vstupni data do modelu. Dulezitym
faktorem je i zobrazovani vysledki zaplavovych tizemi na jinych podkladech, nez je digitalni
model terénu. Toto zobrazeni je pak bliz$i i pro neodbornou vefejnost.

Na modelu transportu sedimentli na fece Opavé nebyly zjistény vyznamné zmeény
ve stavu koryta toku. Nemél by tento problém byt opominan a je vhodné tuto problematiku
resit. U fek, které mohou byt vice postizené erozi a vymilanim, by méla byt tato problematiky
do sledovani vodniho toku zahrnuta.

Transport sedimentd je velmi vyznamny a jeho sledovani by nemélo byt opominano
zejména pii stavbé riznych vodnich nadrzi ¢i vodnich d€l na tocich. Snizovanim pritoku
u té€chto tokl vlivem transportu sedimentli, by mohlo dochazet k zandSeni téchto nakladnych

vodnich dél a k nésledné pottebe odstraiiovani transportovanych sedimentt.
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10. Seznam symboli, oznaceni a zkratek

A [-] kriticky parametr mobility sedimentt (Acker-White)

A B [-] experimentalni  soucinitelé (A=0,047, B=0,25) (Engelund-
Hansen)

AL [-] soucinitel délky kroku ¢astice

c [kgm™] soucinitel obrusu — coefficient of abrasion

C [kgm™] koncentrace splavenin v hloubce y

Co [-] odporovy soucéinitel

Cexp [-] koeficient stanoveny na zakladé experimentd (Acker-White)

cf [-] koeficient tfeni

CL [-] vztlakovy soucinitel

Cm [kgm™] prutok koncentrace sedimentt

Cse [kgm™] koncentrace sedimenti

d [mm] prumér zrna

D [-] soucinitel difuzivity

de [mm] efektivni primér zrna

Dn [-] efektivni hloubka

ds [m] zména drahy

Fgs,FL [N] vztlakova sila

Fo [N] odporova sila

Fe,G [N] gravitacni sila

For [-] parametr mobility sedimentti

Fr [N] Vztlakova sila

Fr [-] Froudovo cislo

G [a] hmotnost zrna na konci vykonané drahy

[ms-?] gravitacni zrychleni (=9.81)

Go [a] hmotnost zrna na zac¢atku drahy

Op [kgs™] hmotnostni priitok plavenin

Gs [N] tiha télesa

gs’ [kgs™] hmotnostni pritok splavenin na jednotku sitky koryta

Ose [kgs™] hmotnostni priitok plavenin a splavenin (sedimenti1)
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ks, ka, ks

Rex

S.F.

U=

Ukr

AV

V1

Vs

Ws

Ys

[ms’]

[ms™]
[Nm?]
[N'm™]

tloustka, hloubka
sklon dna (normal depth)
konstantni objem
tvarové soucinitele
drsnost dna (makrodrnost)
povrchova drsnost vyvolana zrnem (mikrodrsnost)
konstanta plochy ¢astice
konstanta ¢asového méftitka Castice
konstanta objemu castice
parametr koncentrace sedimenti

pocet vrstev
exponent teploty
pravdépodobnost, ze dojde k vymleti castice
hmotnostni procento frakce materialu dna
hmotnostni procento frakce dnovych splavenin
pratok splavenin na dn¢
hydraulicky polomér
Reynoldsovo ¢islo

splaveninové Re ¢islo
sklon
tvarovy soucinitel

rychlost vody u dna
primérnd rychlost proudu
tteci rychlost
kriticka rychlost

prufezova rychlost Cisté vody
ptirtstek rychlosti mezi spodni pfilehlou vrstvou a horni vrstvou
objem vody a splavenin

objem splavenin
prufezova rychlost vody a splavenin
sedimentacni rychlost

meérnd tiha vody

meérnd tih ¢astice
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8 [m]

6 [-]

A [m]

v [m?s™]
p [kgm™]
Ps [kgm™]
0 [Pa]

Te, Tokr [Pa]

¢ [-]

X [-]

X [-]
ZKRATKY:
1D,2D,3D

CAD

CUZK
DIBAVOD

DTM

FEMA

GIS

HEC —RAS
LiDAR

s.p.

TIN

ZABAGED

tloustky vizkézni podvrstvy
Shieldiv parametr

Vvlnova délka

kinematicka viskozita (v=p/p;dynamicka viskozita/hustota vody)

mérna hmotnost vody

mérna hmotnost ¢astice, hustota ¢astice

tecné napéti

kritické tecné napéti na dné

intenzita pohybu dnovych splavenin
kvantitativni charakteristika splavenin (DuBoys)

koeficient popisujici charakteristiku splavenin (Schoklist)

Jedno-, dvou-, ttirozmérny

Computer Aided Design —pocitatem podporované navrhovani
Cesky ufad zeméméficsky a katastralni

Digitalni baze vodohospodatskych dat

Digitalni model terénu

Federal Emergency Management Agency

Geograficky informacni systém

Hydrologic Engineering center — River Analysis Systém
Light Detection And Ranging

statni podnik

Triangulated irregular network

zakladni baze geografickych dat Ceské Republiky
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13. P¥ilohy

SEZNAM PRILOH

1. Vytvoiené mapy K popisu uzemi

2. Postup prace v ArcMap s extenzi HEC-geoRAS (pre - procesing)

3. Vystupy z vytvareni vstupnich dat do HEC — RAS v ArcMapu (pre — procesing)
4. Zrnitostni sloZeni vzorkii jak byly vkladany do souboru o sedimentech

5. Zobrazeni vysledki z programu HEC — RAS (zvétSeni)

6. Mapy vytvorené v RASMapper — GIS nastroj v ramci HEC - RAS

7. Postup exportu vysledki do ArcGIS
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